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Turbo C is for C programmers who want a fast, efficient compiler; for
Turbo Pascal programmers who want to learn C with all the “Turbo”
advantages; and for anyone just learning C who wants to start with a fast,
easy-to-use implementation.

The C language is a structured, modular, compiled, general-purpose
language traditionally used for systems programming. It is portable, so you
can easily transfer application programs written in C from one system to
another. You can use C for almost any programming task, anywhere. But
while traditional C compilers plod along, Turbo C flies through compil-
ation, and gives you more time to test and perfect your programs.

The Turbo C Package

Your Turbo C package consists of a set of distribution disks and the two-
volume manual—the Turbo C User’s Guide (this book) and the Turbo C
Reference Guide. The distribution disks contain all the programs, files, and
libraries you need to create, compile, link, and run your Turbo C programs;
they also contain sample programs, several stand-alone utilities, a context-
sensitive help file, an integrated debugger, and additional C documentation
not covered in these guides.

The User’s Guide is designed as a handbook and guide for the beginner and
a useful refresher course for the experienced C user. The Reference Guide is
first and foremost a detailed list and explanation of Turbo C’s extensive
library functions. It also contains information on the Turbo C editor, error
messages, utilities (CPP, MAKE, TLINK, TLIB, GREP, BGIOBJ, and
OBJXREF), command-line options, Turbo C syntax, and customization.
Unless you are already a C programmer, you will probably want to begin
with the User’s Guide before wading into the deeper waters of the Reference
Guide.
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What's New in Turbo C 2.0

Turbo C 2.0 includes many new and improved features:

mintegrated debugging: Step and trace through code, set breakpoints,
watch and evaluate expressions

m a faster compiler (20 to 30%) and linker

m EMS storage for the edit buffer: Gives you up to 64K more memory for
compiling and running

m faster memory allocation and string functions

m faster floating-point emulation

m new signal and raise functions

man__emit__ feature that lets you insert machine code into your program
at compile time

man enhanced BGI graphics library, with many new functions, including
installable drivers and fonts

m support for command-line wildcard expansion

® linker can create .COM files for tiny model programs

m support for Borland’s new standalone debugger

m autodependency checking for the MAKE utility

m support for long double constants and variables

B new editor features, including block indent/unindent and optimal fill

Requirements

Turbo C runs on the IBM PC family of computers, including the XT, AT,
and PS/2, along with all true IBM compatibles. Turbo C requires DOS 2.0
or higher and at least 448K of RAM; it will run on any 80-column monitor.
Ore floppy disk drive is all that’s required, although we recommend two
floppy drives or a hard disk with one floppy drive.

Turbo C includes floating-point routines that let your programs make use
of an 80x87 math coprocessor chip. It will emulate the chip if it is not
available. The 80x87 chip can significantly enhance performance of your
programs, but it is not required.

The Turbo C Implementation

Turbo C supports the Draft-Proposed American National Standards
Institute (ANSI) C standard, fully supports the Kernighan and Ritchie
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definition, and includes certain optional extensions for mixed-language and
mixed-model programming that allow you to exploit your PC’s
capabilities.

Volume I: The Turbo C User’s Guide

The Turbo C User’s Guide (this volume) introduces you to Turbo C, shows
you how to create and run programs, and includes background information
on topics such as compiling, linking, debugging, and project making. Here
is a breakdown of the chapters in the User’s Guide:

Chapter 1: Before You Begin tells you how to install Turbo C on your
system. It also suggests how you should go about using the rest of the
User’s Guide.

Chapter 2: Getting Started teaches you basics about using the Turbo C
integrated development environment (TC) to load, compile, run, edit and
save a simple Turbo C program.

Chapter 3: Putting It All Together—Compiling and Running Your
Program shows how to use the Turbo C Run command, and explains how
to “make” (rebuild) a program’s constituent files.

Chapter 4: Debugging Your Program introduces you to the Turbo C
integrated debugger and walks you through a sample program with built-
in bugs to demonstrate various features of the debugger.

Chapter 5: The Turbo C Integrated Development Environment explains
Turbo C’s text editor, integrated debugger, and menu system, and discusses
pick files and configuration files.

Chapter 6: Programming in Turbo C introduces you to some of the basic
steps involved in creating and running Turbo C programs and takes you
through a set of short, progressive sample programs.

Chapter 7: More Programming in Turbo C provides summary
explanations of additional C programming elements including arrays,
pointers, structures, and statements.

Chapter 8: Turbo C’s Video Functions first briefly discusses video modes
and windows, then describes programming in text mode versus pro-
gramming in graphics mode.

Chapter 9: Notes for Turbo Pascal Programmers uses program examples
to compare Turbo Pascal to Turbo C, describes and summarizes the
significant differences between the two languages, and gives some tips on
avoiding programming pitfalls.
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Chapter 10: Interfacing Turbo C with Turbo Prolog shows how to
interface modules written in Turbo C with Turbo Prolog programs and
provides several examples that demonstrate the process.

Chapter 11: Turbo C Language Reference lists all aspects and features of
this implementation that differ from Kernighan and Ritchie’s definition of
the language, and details the Turbo C extensions not given in the current
draft of the ANSI C standard.

Chapter 12: Advanced Programming in Turbo C provides details about
the start-up code, memory organization in the different memory models,
pointer arithmetic, assembly-language interface, and the use of floating-

point.

Volume II: The Turbo C Reference Guide

The Turbo C Reference Guide is written for experienced C programmers; it
provides implementation-specific details about the language and the run-
time environment. In addition, it describes each of the Turbo C functions,
listed in alphabetical order. These are the chapters and appendixes in the
programmer’s Reference Guide:

Chapter 1: Using Turbo C Library Routines lists Turbo C’s (.h) files and
each of its library routines by category, discusses function main and its
arguments, and concludes with a description of each of the Turbo C global
variables.

Chapter 2: The Turbo C Library is an alphabetical reference of all Turbo C
library functions. Each entry gives syntax, include files, an operative
description, return values, and portability information for the function,
together with a reference list of related functions and examples of how the
functions are used.

Appendix A: The Turbo C Interactive Editor gives a more thorough
explanation of the editor commands for those who need more information
than is given in Chapter 5 of the User’s Guide.

Appendix B: Compiler Error Messages lists and explains each of the error
messages and summarizes the possible or probable causes of the problem
that generated the message.

Appendix C: Command-Line Options lists the command-line entry for
each of the user-selectable TCC (command-line compiler) options.

Appendix D: Turbo C Utilities discusses the utilities included in the Turbo
C package: CPP, the preprocessor; MAKE, the program builder; TLINK, the
Turbo Link utility; TLIB, the Turbo librarian; GREP, the file search utility;
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BGIOB]J, a conversion utility for graphics drivers and fonts; and the object
module cross-referencer OBJXREF.

Appendix E: Language Syntax Summary uses modified Backus-Naur
Forms to define the syntax of all Turbo C constructs.

Appendix F: TCINST: Customizing Turbo C takes you on a walk through
the customization program (TCINST), which lets you customize your
keyboard, modify default values, change your screen colors, and so on.

Appendix G: MicroCalc explains how to compile, run, and use MicroCalc,
the sample spreadsheet program included on the Turbo C distribution
disks.

Recommended Reading

You will find these documents useful supplements to your Turbo C
manuals:

® The most widely known description of C is found in The C Programming
Language by Brian W. Kernighan and Dennis M. Ritchie (New Jersey:
Prentice-Hall, 1978).

s The ANSI Subcommittee X3J11 on Standardization of C is presently
creating a formal standard for the language, and Turbo C supports this
upcoming ANSI C standard.

If you are learning C for the first time, we recommend that you use Turbo C
to work through the exercises in Kernighan and Ritchie. If you are
experienced with C, you should have little difficulty using Turbo C.

Refer to the bibliography in the back of this manual for other books on C
and Turbo C.

Typographic Conventions

All typefaces used in this manual were produced by Borland’s Sprint: The
Professional Word Processor, on a PostScript laser printer. Their uses are as
follows:

Monospace type This typeface represents text as it appears onscreen
or in a program, or anything you must type (such
as command-line options or switches).

[] Square brackets in text or DOS command lines
enclose optional input or data that depends on
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your system. Text of this sort should not be typed
verbatim.

<> Angle brackets in text or on DOS command lines
enclose optional input or data that depends on
your system. Text of this sort should not be typed
verbatim.

Angle brackets in the function reference section
enclose the names of include files.

Boldface Turbo C function names (such as printf) and
structure names are shown in boldface when they
appear in text (but not in program examples). This
typeface is also used, in text but not in program
examples, for Turbo C keywords such as char,
switch, near, and cdecl.

Italics Italics indicate variable names (identifiers) that
appear in text. They are also used to emphasize
certain words (especially new terms).

Keycaps This special typeface indicates a key on your key-
board. It is often used to describe a particular key
you should press; for example, “Press ES¢ to exit a
menu.”

Borland’s No-Nonsense License Statement

This software is protected by both United States copyright law and
international treaty provisions. Therefore, you must treat this software just
like a book with the following single exception: Borland International
authorizes you to make archival copies of Turbo C for the sole purpose of
backing up your software and protecting your investment from loss.

By saying, “just like a book,” Borland means, for example, that this
software may be used by any number of people and may be freely moved
from one computer location to another so long as there is no possibility of
its being used at one location while it’s being used at another.

How to Contact Borland

The best way to contact Borland is to log on to Borland’s Forum on
CompuServe: Type G0 BOR from the main CompuServe menu and choose
“Borland Programming Forum B (Turbo Prolog & Turbo C)” from the
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Borland main menu. Leave your questions or comments there for the
support staff to process.

If you prefer, write a letter with your comments and send it to:

Technical Support Department
Borland International
1800 Green Hills Road
P.O. Box 660001
Scotts Valley, CA 95066-0001, USA

You can also telephone our Technical Support department at 408-438-5300.
Please have the following information handy before you call:

m Product name and serial number on your original distribution disk.
Please have your serial number ready, or we will be unable to process
your call.

m Product version number. The version number for Turbo C is displayed
when you first load the program and before you press any keys.

m Computer brand, model, and the brands and model numbers of any
additional hardware.

m Operating system and version number. (The version number can be
determined by typing VER at the MSDOS prompt.)

m Contents of your AUTOEXEC.BAT file.
= Contents of your CONFIG.SYS file.
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Before You Begin

Your Turbo C package actually includes two different versions of the C
compiler: the integrated development environment version and a separate,
stand-alone, command-line version. When you install Turbo C on your
system, you copy files from the distribution disks to your working floppies
or to your hard disk. There is no copy protection, and an installation pro-
gram is included to make it simple to install Turbo C. The distribution
disks are formatted for double-sided, double-density disk drives and can be
read by IBM PCs and close compatibles. For reference, we include a list of
the distribution files in the README file on the Installation Disk.

We assume you are already familiar with DOS commands. For example,
you will need the DISKCOPY command to make backup copies of your
distribution disks. If you do not already know how to use DOS com-
mands, refer to your DOS reference manual before starting to set up Turbo
C on your system.

You should make a complete working copy of the distribution disks when
you receive them, then store the original disks away in a safe place. Do not
run Turbo C from the distribution disks; they are your original (and only)
backups in case anything happens to your working files.

If you are not familiar with Borland’s No-Nonsense License Statement, now
is the time to read the agreement in the Introduction (it’s also at the front of
this book) and mail us your filled-in product registration card.
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In This Chapter...

We begin this chapter with instructions for accessing the README file and
installing Turbo C on your system. The rest of the chapter is devoted to
some recommendations on which chapters you should read next, based on
your programming language experience.

The README File

It is very important that you take the time to look at the README file on
the Installation Disk before you do anything else with Turbo C. This file
contains last-minute information that may not be in the manual. It also lists
every file on the distribution disks, with a brief description of what each
one contains.

To access the README file, insert the Installation Disk in Drive A, switch
to Drive A by typing A: and pressing Enter, then type README and press Enter
again. Once you are in README, use the Up and Down arrow keys to scroll
through the file. Press Esc to exit.

The HELPME!.DOC File

Your Installation Disk also contains a file called HELPME!.DOC, which
contains answers to problems that users commonly run into. Consult it if
you find yourself having difficulties.

Installing Turbo C on Your System

Your Turbo C package includes all the files and programs necessary to run
both the integrated-environment and command-line versions of the
compiler, along with start-up code and library support for six memory
models and 8087/80287 coprocessor emulation. If you are installing Turbo
C for the first time, or installing the upgrade from the previous version
(1.5), the INSTALL program makes it easy.
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If You Are Installing Turbo C on a Floppy-Disk
System

If your system has one or two floppy disk drives but no hard drive, you
must have a set of three formatted, empty disks ready before you run
INSTALL.

Each time you run INSTALL, it will let you install Turbo C with one
memory model. If you want to install more than one memory model, you
must have additional sets of disks, one for each memory model you want to
install.

Running INSTALL

The Turbo C installation program INSTALL is designed to walk you
through the installation process. All you have to do is follow the instruc-
tions that appear onscreen at each step. Please read them carefully.

To run INSTALL:

1. Insert the distribution disk labeled Installation Disk in Drive A.
2. Type A: and press Enter.
3. Type INSTALL and press Enter.

From this point on, just follow the instructions that INSTALL displays
onscreen.

As soon as INSTALL is finished running, you are ready to start using Turbo
C.

Note: After you have tried out the Turbo C integrated development envi-
ronment, you may want to permanently customize some of the options. We
give you a program called TCINST that will make this easy to do. See
Appendix F in the Turbo C Reference Guide for instructions.

Setting Up Turbo C on a Laptop System

If you have a laptop computer (one with an LCD or plasma display), in
addition to carrying out the procedures given in the previous sections, you
should set your screen parameters before using Turbo C. The Turbo C Inte-
grated Development Environment version (TC.EXE) works best if you enter
MODE BW80 at the DOS command line before running Turbo C.
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Alternatively, you can install TC for a black-and-white screen with the
Turbo C customization program, TCINST. Refer to Appendix F in the Turbo
C Reference Guide. With this customization program, you should choose
“Black and White” from the Screen Modes menu.

MicroCalc

We have included the source code for a spreadsheet program called
MicroCalc. Before you try to compile it, read Appendix G in the Turbo C
Reference Guide.

Where to Now?

Now that you have finished installing Turbo C, you are ready to start
digging into this guide and using Turbo C. But since this user’s guide is
written for four different types of users, certain chapters are written with
your particular Turbo C programming needs in mind. Take a few moments
to read the following, then take off and fly with Turbo C speed!

Programmers Learning C

If you are just now learning the C language, you will want to start with
Chapters 2 and 3, which introduce you to the Turbo C integrated
development environment and show you how to load, compile, link, and
run a simple Turbo C program, as well as how to edit and save your own
creations. Chapter 4 will introduce you to the Turbo C integrated debugger.
Next, read Chapters 6 and 7. These are written in tutorial fashion and take
you through the process of creating and compiling C programs. If you are
not sure how to use the integrated development environment, you will
need to read Chapter 5. Chapter 8 will introduce you to Turbo C’s exciting
graphics features.

Experienced C Programmers

If you are an experienced C programmer, you should have little difficulty
porting your programs to the Turbo C implementation. You will want to
read Chapter 11, “Turbo C Language Reference,” however, for a summary
of how Turbo C compares to Kernighan and Ritchie and to the draft ANSI
C standard. When you are ready to port or create C programs with Turbo
C, you will need to read Chapter 3, “Putting It All Together—Compiling,
Debugging, and Running,” Chapter 4 about how to use the Turbo C
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integrated debugger, and Chapter 12, “Advanced Programming in Turbo
C.” If you are interested in exploring what you can do with Turbo C
graphics, read Chapter 8.

Turbo Pascal Programmers

Chapter 9, “Notes for Turbo Pascal Programmers,” is written specifically
for you; in it, we provide some examples that compare Turbo Pascal pro-
grams with equivalent Turbo C programs, and we elaborate on some of the
significant differences between the two languages.

If you have programmed with Turbo Pascal, you are familiar with the
seven basic elements of programming. To get up to speed with Turbo C,
you will want to read Chapters 5, 6, and 7. (If you have used another
menu-driven Borland product, such as SideKick or Turbo Basic, you will
only need to skim Chapter 5.) You should also look at Chapter 3, on
compiling and running your Turbo C programs, and Chapter 4, on the
Turbo C integrated debugger.

Turbo Prolog Programmers

If you have used Turbo Prolog and would like to know how to interface
your modules with Turbo C, you should read Chapter 10.
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Getting Started

Now you have Turbo C installed on your system, and you are ready to start
programming. But first you have to find out a few basics, like how to run
Turbo C, how to use a text editor to create and modify your programs, and
how to compile and run them.

You can use any ASCII text editor to create your programs, and then
compile and run them from the DOS command-line using the command
line compiler (the TCC version of Turbo C). However, you will probably
find it easier, at least at first, to work in the Turbo C integrated
development environment (the TC version of Turbo C), which provides
you with an editor, a menu system of Turbo C commands, an integrated
debugger, and a built-in Project-Make facility that lets you compile and run
your programs from within the TC environment.

Note: We will explain as we go along how to use the TC menus to perform
the exercises in this chapter. If you want a comprehensive explanation of
the whole TC menu system, refer to Chapter 5 in this manual.

In This Chapter...

We start out by teaching you a few basic skills that you will need to use
Turbo C: loading the Turbo C integrated development environment (TC),
loading a program into Turbo C, and building and running the program.

Next, we show you how to modify your program, using the TC Editor.

Finally, we show you how to create an all-new Turbo C program and save
it to its own file before you build and run it.
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HELLO.C: Building and Running a Single-
File Program

Let’s start out easy. Before you plunge in and start writing programs of
your own in Turbo C, let’s practice using the integrated development
environment (TC) version of Turbo C with a program that already exists.

In the directory where you installed your example programs, there is a file
called HELLO.C that contains the source code for a very simple program.
Working with it will demonstrate for you the six steps to building and
running a single-file Turbo C program.

Step 1: Load TC

If you installed Turbo C with the INSTALL program, TC should already be
in your main Turbo C directory. Just go into that directory and load TC by
typing TC on the DOS command line and pressing Enter.

Note: If you want to do your programming in a separate working directory
instead of in the directory that contains TC, you have to tell DOS where to
find the TC program:

m Specify the directory with TC in it by using the DOS PATH command.
(See PATH in your DOS manual; be careful that you do not destroy
existing PATHs when you enter the TC path.).

m In 3.x versions of DOS, you can type the path name to TC directly on the
command line, for example, \TURBOC\TC.

Step 2: Choose the Working Directory (Optional)

If your current directory is the one that contains HELLO.C, you can skip
this step.

Choose the drive and directory that contain HELLO.C, the source file you
want to load. Do this by going to the pull-down File menu (press F10, then
F, or just press Alt-F). Select Change Dir (use the arrow keys to position the
highlight bar and press Enter, or just type C). When the New Directory
prompt box appears, type in the name of the directory that contains
HELLO.C and press Enter. This directory becomes the current directory.

Note: When the New Directory prompt box comes up, it lists the current
directory. That means you can use the File/Change Dir option to check
what directory you are in; simply choose it, so that the New Directory
prompt box appears, then press Esc to get back to the menus without
changing the current directory.
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Step 3: Set Up Your Working Environment

If you used the INSTALL program to install Turbo C on your system, the
working environment has been set up for you already. You may want to
read this section anyway, to verify that your environment is set up
correctly.

To set up and save your working environment, press F10, then O (or press
Alt-0) to invoke the Options menu from the main menu bar. Then select
Directories to bring up the Directories menu. You will need two of the
items on this menu: Include Directories and Library Directories.

Choose Include Directories, then type the name of the drive and directories
that contain the Turbo C standard include files (h files), separating the

directory names with semicolons. The include directories will usually be
CA\TURBOC\INCLUDE and C:\TURBOC\INCLUDE\SYS; you would

type

C:\TURBOC\INCLUDE; C: \TURBOC\ INCLUDE\SYS
and press Enter.

Now choose Library Directories, and type in the name of the drive and
directory that contains the Turbo C library and startup files. (This will
usually be C:\TURBOC\LIB.) Other directory names may be entered;
separate them with semicolons. ’

Note: At this point, if you wish, you can set the output directory (where
your compiled program will be stored) with the Options/Directories/
Output Directory command. If you do choose an output directory, all
compiler and linker output will be written to that directory instead of to the
directory you are currently in. In our present example case, it is not
necessary to set an output directory.

For most simple cases, this is all the setup necessary for building C pro-
grams.

You can save the settings for your working environment in a configuration
file that is loaded automatically when you start TC. Press Esc to get back to
the Options menu, then choose Save Options to write the current options to
a configuration file on disk. The default file, TCCONFIG.TC, will be written
to the current directory.

Note: When it starts up, TC looks in the current directory for a file called
TCCONFIG.TC, which it loads if the file is present. If you wish, you can
give the configuration file another name by typing in the new name and
pressing Enter. If you do this, however, you will need to load this config-
uration file explicitly the next time you enter TC, either by typing its name
on the TC command line with the /c switch (see Chapter 5 on TC
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command-line switches), or by using the Options/Retrieve Options com-
mand.

Note: When you are working on a particular program, it is useful to have a
default configuration file in the same directory as the program and to start
TC from that directory. However, if the configuration file is not found in the
current directory, TC will also look in the Turbo C directory. This means
that you can keep one general purpose configuration file in the Turbo C
directory and others in your various source file directories that use dif-
ferent settings.

Step 4: Load the Source File into the Editor

Now load HELLO.C. Choose the Load command from the File menu, or
press F3, the file load hot key. A prompt box will appear containing the
wildcard notation *.C. Type in HELLO (you do not need to include the .C
extension), and press Enter.

Note: If you aren’t sure about the name of the file you want to load, or you
want to see a listing of all the source files in the current directory, just press
Enter instead of typing in the file name. TC will display a menu of all the
available .C source files in the directory. To choose a file, use the arrow keys
to move the highlight bar to the name of the file you want, then press Enter.

The HELLO.C file is now displayed in the TC Editor window. It should
look like this:

/*  HELLO.C -- Hello, world */
$include <stdio.h>

main()
{

printf("Hello, world\n");
}

Note: It is possible to load TC, the source file, and the configuration file
from the command line, which eliminates having to bother with Steps 2, 3,
and 4. The integrated development environment accepts two command-
line arguments that accomplish this: the file name of a source code file to be
loaded into the editor, and a /c switch immediately followed by the name
of the configuration file you want to load with the source file. These two ar-
guments can be in any order. Thus,

tc hello /cmyconfig

will place HELLO.C in the editor and load the configuration file
MYCONFIG.TC. (Note that there is no space between the /c switch and the
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file name, and that the default extension .C is assumed for the edit file and
the default extension .TC is assumed for the configuration file.)

Step 5: Build the Executable File

When you build a program, you first compile the source code to create an
object file (a machine code file with an .OBJ extension). Then you send the
object file to the linker to be converted to an executable file with a .EXE
extension. The linker copies into your object file certain necessary
subroutines from the standard run-time library files. (You told Turbo C
where to find these library files, remember, back when you set up your
working environment.)

In this simple case of a single-file program, you can build and run the pro-
gram without creating a project file (more on project files in Chapter 3).

Though there are other approaches, the easiest way to build your program
is to press F10, then C to bring up the Compile menu (or press Af-C), then
choose Make EXE File (or press F9, the make .EXE file hot key). Observe
that the Compile menu tells you the name of the object (.OBJ) file that will
be compiled and the .EXE file that will be built.

The Compiling window will appear on the screen, and Turbo C should
successfully compile and link your program. If all goes well, the Compiling
window will give you a flashing Press any key message.

Note: If there is anything wrong with your program, you will see error
messages or warnings in the Message window at the bottom of the screen.
If this happens, make sure that your program is typed in exactly as it is in
Step 4, then compile it again.

Step 6: Run the Program

At this point, you should have an executable program.

Now, to run your program, choose Run from the Run menu, or press Ctri-F9,
the run program hot key.

What happened? You saw the screen flash, and then you were back in the
main TC screen. To see the output from the program, select Run/User
Screen, or press Alt-F5. This brings up the User screen, which is where your
screen output went.

The User screen should contain the message
Hello, world
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After you have examined your program output, press any key to return to
the TC screen.

What Have You Accomplished?

Now get out of Turbo C (choose the Quit command from the File menu or
press Alt-X).

Let’s look at what you've created.

At the DOS prompt, type dir hello.* and press Enter. You'll get a list of files
that looks something like this:

HELLO c 104 5-11-88 2:57p
HELLO 0BJ 458 5-11-88 3:01p
HELLO EXE 8884 5-11-88 3:01p

The first file, HELLO.C, is the source for your program. It contains the text
(the source code) of your program. You can display it on the screen; just enter
(at the DOS prompt) the command type hello.c. As you can see, HELLO.C
isn’t very big—only 104 bytes.

The second file, HELLO.OB]J, is your object file. It contains the binary
machine instructions (the object code) produced by the Turbo C compiler. If
you use the DOS TYPE command to display this file onscreen, you'll get
mostly gibberish.

The last file, HELLO.EXE, is the actual executable file produced by the Turbo
Linker. It contains not only the code in HELLO.OB], but also all the
necessary support routines (such as printf) that the linker copied in from
the library file. To run any executable file, you just type its name at the DOS
prompt, without the .EXE extension.

To run HELLO.EXE, type hello at the DOS prompt, and press Enter. The
message Hello, world will appear on the screen, and the DOS prompt will
come back again.

Editing Your Program

Tradition has it that your first C program should always be the Hello, world
program found in the classic work, The C Programming Language by
Kernighan and Ritchie. This is the little HELLO.C program you have just
finished building and running.

Are you feeling brave? Now that you are somewhat familiar with the Turbo
C integrated development environment, let’s try doing some programming
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of your own. We'll start by making some modifications to the HELLO.C
program. To do this, you must learn to use the TC Editor.

If you're not already there, get back into Turbo C by typing tc hello at the
DOS prompt. You'll find yourself back in TC, with your program already
loaded in.

Now let's modify your program so that you can interact with it a little.

Notice the flashing cursor in the upper left corner of the screen. You can
move this cursor around the Edit window with the arrow keys. To enter
code, just move the cursor to the right spot and type in the code. You can
delete a line of code by pressing Ctr-Y, and insert a line by pressinging Cir/-N.
Make sure you are in Insert mode (the word Insert should appear in the
status line at the top of the Edit window; if it doesn’t, press Ins to toggle it
on). (For complete information on how to use the TC Editor, see Chapter 5
in this manual and Appendix A in the Turbo C Reference Guide.)

Go ahead and edit your program so it looks like this:

$include <stdio.h>

main()
{

char name[150];

printf("What’s your name?\n");
scanf (“%4s",name) ;
printf(“Hello, %s\n",name);

}

You've added three lines to HELLO.C. The first line (char name[150]};)
declares a variable named name, which can hold a string of up to 150
characters (letter, digit, punctuation, etc.). (Position 150 is reserved for a
special character that we’ll tell you about later.) The second line you added
calls the function printf to write out the message What’s your name?. The
third new line calls the function scanf to read a name into the variable
name.

Next, press Ctrl-F9 to run your program. Notice that Turbo C is smart
enough to know that you have modified your source code, so it recompiles
the program before running it.

This time when your program runs two things happen: The User screen
appears, with the message What’s your name? and the cursor waiting on the
next line. Type in your name and press Enlor. Press Alt-F5. The User screen
now says Hello, <your_name>. Note that it only read the first name you
typed in; you'll learn why in Chapter 6. For now, press any key to return to
the TC screen.
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If You Did Something Wrong

As you write programs, you will make errors or receive warnings. An error
is a mistake in your program that prevents Turbo C from compiling it to
make object code. A warning is just that: a message that points out a
possible problem. Errors and warnings appear in the Message window at
the bottom of the TC screen. There are many different errors and warnings;
they are covered in more detail in Appendix B of the Turbo C Reference
Guide.

Sending Your Output to a Printer

Are you wondering how to send your HELLO.EXE program output to a
printer instead of to the screen? We’ll show you how here, although we
won’t go into the details of how this works just yet; you have plenty to
learn for now, and we want to save some of the fun for later.

Load HELLO.C into the Editor, and modify it to look like this:

$include <stdio.h>

main{()

{
fprintf(stdprn, "Hello, World\n");

)

Make sure your printer is ready, then compile and build your program just
as you did before, by pressing Ctr-F9. Your printer should print out the
message Hello, world.

Note that this time we’ve used the fprintf function instead of printf. As
you gain more expertise with Turbo C and venture into the Turbo C
Reference Guide, you'll learn more about these elements we’ve added.

Writing Your Second Turbo C Program

Now let’s modify your HELLO.C program some more, and store it in a new
file. You should still be in the Editor, but if you aren’t (if there is no flashing
cursor), either press Alf-E for the quick shortcut, or press F10 to activate the
menu system, and E to select the Editor. Now change your program so that
it looks like this:
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$include <stdio.h>

main{)
{

int a,b,sum;

printf(“Enter two numbers: *");

scanf("%d %d",&a,&b);

sum = a + b;

printf(“The sum is %d \n",sum);
}

You have made five changes to the original program. You have
mreplaced the line defining name with one defining other variables (a, b,
and sum, all integers)
m changed the message in the printf statement
= changed the format string and variable list in the scanf statement
m added the assignment statement sum = a + b;
m changed the format string and argument list in the final printf statement

Don’t let the percent signs (%), ampersands (&), and backslashes (\)
confuse you; we’'ll explain what they mean in Chapter 6.

Writing to Disk

Now, do not press the F2 function key. If you do, this program will be saved
as HELLO.C (you are going to save it under a different name).

Instead, press Al-F to get to the File menu. Press W to select the Write To
command. Turbo C will ask you to type in the new name for this program;
type sum.c and press Enfer. Your second program has now been saved on
disk as SUM.C.

Running SUM.C

Press Ctr-F9. Turbo C will compile your program. If there are any errors, go
back into the editor and be sure that what you've typed in matches exactly
what is given in the example.

Once there are no errors, Turbo C will link in the appropriate library
routines and then run your program. The User screen will appear, with this
message:

Enter two numbers:
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Your program is waiting for you to enter two integer values, separated by
blanks and/or tabs and/or carriage returns. Be sure to press Enfer after
typing the second value. Your program now prints the sum of those two
values on the User screen; select Run/User Screen (or press Alf-F5) to see the
result. Press any key to return to Turbo C.

Congratulations! You've now written two completely different Turbo C
programs using several of the basic elements of programming. Are you
wondering what those elements are? You can find out by reading Chapter
6, before going on to Chapter 7.
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Putting It All Together—Compiling
and Running Your Program

Now that you have had some experience using Turbo C, let’s move on to
some more complicated issues—more advanced features of the Turbo C
integrated development environment, and command-line Turbo C.

Turbo C provides a flexible environment for C program development; it
comes with default option settings to get you started, but you can easily
change these defaults to best meet your programming needs. Turbo C also
provides various support tools to perform the routine chores associated
with program development, such as error tracking and file-system
management.

If you are not familiar with Borland’s easy-to-use integrated development
environment (TC), you should look over Chapter 5 before compiling and
running your programs through TC’s menu system. It is a logical and easy
system to learn, and it won't take long for you to feel comfortable using it.

In This Chapter...

Because you can compile and run your Turbo C programs either from the
integrated development environment or from a standard DOS command
line, we discuss both processes in this chapter. However, because the inte-
grated development environment is a complete package, powerful and
easy to use, we think you will want to know about it first.

We begin this chapter with a brief review of how you compile and link
Turbo C source files through the integrated development environment to
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produce executable programs. This is followed by a brief discussion of TC
Turbo C’s debugging features.

We then demonstrate how to run your programs from the integrated devel-
opment environment; we also introduce TC’s built-in Project facility,
Project-Make, and demonstrate how to use it.

After showing you how to run programs within the integrated devel-
opment environment, we explain how to use the command line for
compiling, linking, making (rebuilding), and running your Turbo C pro-
grams. In addition to the integrated development environment version of
Turbo C, your package includes a stand-alone compiler (TCC), linker, and
MAKE utility. Specific details on these stand-alone programs are given in
Appendixes C and D of the Turbo C Reference Guide.

Building Files in TC, Revisited

Building a new program in the Turbo C integrated development envi-
ronment (TC) usually entails going through the following steps:

1. Set directory options so the compiler and linker know where to find and
store things.

2. Load the program you want to build into the TC Editor. (Note: If the
program consists of more than one module, you need to create a project
file that lists the names of your modules.)

3. Build the executable program file.

The exact procedure in these general steps differs depending on whether
you're working with one file or several files as your source.

Debugging Your Program

Finding and fixing errors in your programs is always one of the more
frustrating aspects of programming. The Turbo C integrated development
environment (TC) makes your job a lot easier by providing debugging
features to help you out on both the compile-time and the run-time levels.

Catching Syntax Errors: The Error-Tracking Feature

One of the best reasons to use TC is that it lets you fix syntax (compile-
time) errors and evaluate any warnings the compiler gives you. TC collects
compiler and linker messages in a buffer and then displays them in the
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Message window. This lets you look at all the messages at once while you
still have direct access to your source code.

To try this out, add some syntax errors to the HELLO.C program. Remove
the ¢ from the include statement on the first line. Next take out the trailing
quotation mark in the printf string on the fifth line. The now-buggy file
should look like this:

include <stdio.h>

main ()
{
printf(“Hello world\n);

}

Now compile the file again by pressing Alf-F9 (the compile to .OB]J hot key).
The Compiling window will tell you how many errors and warnings you
have introduced (there should be two errors and no warnings).

The Message Window

When you see the message Press any key in the Compiling window, press
the spacebar. The Message window will become active, and a highlight bar
will be placed on the first error or warning. Since the first error occurred in
the file that is currently in the editor, you will also see a highlighted line in
the Edit window. This marks the place in your source code where the
compiler generated the error or warning,.

At this point you can use the cursor keys to move the Message window’s
highlight bar up and down to view other messages. Notice how the
highlight bar in the Edit window tracks where the compiler thinks each
error occurred in your source. When you place the highlight bar on the
“compiling” message, the editor shows you your last position in that file.

If the text in the Message window is too long to see, you can use the Left
and Right arrow keys to scroll the message horizontally. To view more
messages at once, you can zoom the Message window by pressing F5.
When the Message window is zoomed, you cannot see the Edit window, so
no tracking occurs. For now, leave the windows in split-screen mode.

Correcting a Syntax Error

To correct an error, place the Message window highlight bar on the first
error message and then press Enter. Your cursor shifts to the Edit window
and is placed at the spot that generated the error message. Notice that the
status line of the editor shows the message you chose (this is useful when
you work in zoomed mode). You can now correct the error that generated
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the message. (You'll have to put the # you took out earlier back in the first
line.)

Since there is more than one error message, there are two ways to proceed
to fix the next error.

The first method is to return to the Message window by pressing F6 and
choosing the next message you want to fix, as previously described.

However, you do not need to return to the Message window to get to the
next error. Instead, you can simply press Alt-F8 and the editor will place the
cursor at the location of the error listed next in the message window. You
can also move backward to the previous error by pressing Alt-F7.

There are certain advantages to both these methods, and usually circum-
stances dictate which method is preferable. Sometimes one silly mistake in
the source can confuse the compiler, producing many messages. In this
case, choosing and fixing the first message makes the next few error
messages meaningless. When this happens, it is more convenient to use
method one—to return to the Message window after fixing the first error,
scroll down to the next meaningful message, then choose it. In other cases,
however, you may wish to check each message in sequence; pressing Al-F8
is more effective in such situations.

Remember that Alt-F7 and Alt-F8 are hot keys; that is, they work from any-
where within TC. Thus if you are in the Message window and you press
Alt-F8, you don’t get the message that is currently highlighted but the one
after it. (If you want to choose the current message, press Enter.) If there are
no further compiler messages, Alt-F8 has no effect.

Note: You cannot choose linker messages this way, and they will not track
in your source.

In the course of fixing syntax errors, it is often necessary to add and delete
text. The editor keeps track of this: When you proceed to the next error, it
correctly positions the cursor on the error. You don’t need to remember line
numbers or keep track of added or deleted lines of text.

Catching Run-Time Errors: The Integrated Debugger

Once you have fixed all the syntax errors, your program will compile
perfectly well. But it still may not run the way it should, because it may
contain logic (run-time) errors. The error-tracking feature is no help in
finding these.

To catch run-time errors, TC features an integrated debugger. You can run
your program through the debugger, stop it at any point, check the value of
variables, and even change values to test how your program will react. For
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a tutorial on how to use the TC integrated debugger, read Chapter 4 in this
manual.

Projects: Using Multiple Source Programs

One of the great things about TC is its ability to handle separate
compilation of multiple source files. And TC’s Project-Make facility makes
it even more effective.

In the examples in Chapter 2, you were working with only one source file,
so you could just use the Compile/Make EXE File command to make an
executable file. When you build a program from more than one C source
file, however, you have to tell TC exactly which files are involved. That
means you have to create a project file.

Creating a project file is as simple as listing the names of your C source
files. Even though, as you will see, you can list a lot of different files in your
project file let’s keep it simple for now with a two-file program.

One basic case is to have a main program file and a support file that
contains functions or data referenced from the main file. For example, the
main file called MYMAIN.C might look like this:

#include <stdio.h>

main (int arge, char *argv())
{

char *s;

if (argec > 1)
s = argv(1);
else
s = "the universe”;

printf("%s $s.\n",GetString(),s);
}
And the support file called MYFUNCS.C might look like this:

char ss [] = "The restaurant at the end of";

char *GetString(void)
{

return ss;

}
Go ahead and create MYMAIN.C and MYFUNCS.C.

These two files now give you something to work with to build a project file.
The project file will simply contain two lines naming the files to be
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compiled and linked. Create a new file, and type in the two file names, like
this:

mymain
myfuncs

You don’t have to type in the .C extensions. TC assumes any file without an
extension is a .C file (though you can add the .C if you want to). The order
of the files is not important either, except that it determines the order in
which files are compiled. The following project file would have the same
end result as the previous:

myfuncs
mymain

Now save your file as MYPROG.PR] (select Write To from the File menu).
That's all.

Notice that the name of the project file (MYPROG.PR)) is not the same as
the name of the main file (MYMAIN.C). The two names could have been the
same (but not the extensions), but they do not have to be. The important
thing to remember is that the name of your executable file (and any map
file produced by the linker) will be based on the project file’s name. In this
case the executable file will be MYPROG.EXE (and possibly a map file
called MYPROG.MAP).

Also note that you can specify complete path names for any of the files
listed in the project file. In this way, you can build a program without
having all the source files in the same directory.

Building a Multi-Source File Program

Now that you have a project file, all you need to do is tell TC what project
you want to make. This is done by entering the name of the project file on
the project menu. Press Alf-P to get to the Project menu and choose Project
Name. You can explicitly type in the name of your project file or you can
use wildcards to find it in a list of file names in a specified directory. (But
remember, if you haven’t saved the file, it won’t be on disk.) Once your
project name is entered, you can simply press F9 (Make) to make the
executable file. To run this program, press Ctd-F9 (Run/Run).

Note that running a program includes doing a make. This means that pres-
sing Crl-F9 can initiate a compile and link cycle if the files in the project
need to be recompiled. This means you could have omitted the explicit
make (F9). Select Run/User Screen (or press Alt-F5) to see your output. Press
any key to return to the TC Editor.
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Error Tracking Revisited

In the example of a single-file program, you saw that syntax errors that
generate compiler warning and error messages can be viewed and chosen
from the Message window. Likewise, the Message window handles errors
from multiple-file compilations (or makes).

To see this, introduce some syntax errors into the two files, MYMAIN.C
and MYFUNCS.C. From MYMAIN.C, remove the first angle bracket in the
first line and remove the ¢ in char from the fifth line. These changes should
generate three errors and three warnings in MYMAIN.

Now load MYFUNCS.C and remove the first r from return in the fifth line.
This change will produce two errors and one warning.

Editing these files makes them out-of-date with respect to their object files,
so doing a make will recompile them. Since you want to see the effect of
tracking in multiple files, you need to modify the criterion that Project-
Make uses to decide when to stop. This is done by setting a special toggle
in the Project menu.

Stopping a Make

There are several reasons why the make cycle stops in TC. Obviously,
Project-Make stops once an executable file has been produced. But Project-
Make will also stop to report some type of error.

For example, Project-Make will always stop if it can’t find one of the source
files (or one of the dependency files—to be discussed later) listed in the
project file. You can also force Project-Make to stop by pressing Ctri-Break.

A make can also stop when the compiler generates messages. You can
choose the type of message you want it to stop on by setting the Project/
Break Make On menu toggle. The Break Make On menu defaults to Break
Make On...Errors—which is normally the setting you’ll want to use.
However, you can have a make stop after compiling a file with warnings,
with errors, or with fatal errors, or have it stop before it tries to link.

The usefulness of each of these modes is really determined by the way you
like to fix errors and warnings. If you like to fix errors and warnings as
soon as you see them, you should set Break Make On to Warnings or
maybe to Errors. If you prefer to get an entire list of errors in all the source
files before fixing them up, you should set the toggle to Fatal Errors or to
Link.
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Syntax Errors in Multiple Source Files

To demonstrate errors in multiple files, set Project/Break Make On to Fatal
Errors. To do this, press All-P to get to the Project menu, and choose Break
Make On. Now choose Fatal Errors from the Project/Break Make On menu.

At this point, you should have introduced syntax errors into MYMAIN.C
and MYFUNCS.C. Press F9 (Make) to “make the project.” The Compiling
window will show the files being compiled and the number of errors and
warnings in each file and the total for the make. When the Press any key
message flashes, press the spacebar.

Your cursor should now be positioned on the first error or warning in the
Message window. And if the file that message refers to is in the editor,
there will be a highlight bar in the Edit window showing you where the
compiler detected a problem. Again, you can scroll up and down in the
Message window to view the different messages. Note that there is a
“Compiling” message for each source file that was compiled. These mess-
ages are not errors or warnings but serve as “file boundaries,” separating
the various messages generated by each file.

When you scroll down past a file boundary, the Edit window may or may
not track in the next file, depending on the setting of the Message Tracking
toggle in the Options/Environment menu. The default value is to track
only in the current file.

Thus, moving to a message that refers to a file other than the one in the
editor causes the Edit window’s highlight bar to turn off. If you choose one
of these messages (that is, press Enter on it), TC will load the file it
references into the Editor and place you in the Editor with the cursor on the
error. If you then return to the Message window by pressing F6, tracking
will resume in that file.

But by setting the Message Tracking toggle to All Files, you can track mes-
sages across file boundaries. This means that, when you scroll through the
Message window, TC will automatically load the appropriate file into the
editor so you can see where each message refers. Try it.

You can also turn tracking off completely, by setting the Message Tracking
toggle to Off. In this case, you simply choose the message you wish to work
on and then press Enfer. The file the message refers to will then be loaded
into the editor with the cursor placed on the error.

Note that Alt-F7 and Alt-F8 (Previous error and Next error) are not affected by
the setting of the Message Tracking toggle. These hot keys will always find
the next or previous error and will load the file if necessary.

32 Turbo C User’s Guide



Keeping and Getting Rid of Messages

Normally, whenever you start to make a project, the Message window is
cleared out to make room for new messages. Sometimes, however, it is
desirable to keep messages around between makes.

Consider the following example: You might have a project that has many
source files and you have Break Make On set to stop on Errors. In this case,
you may get several warning messages in several files, but then one file
contains an error so that the make stops. You fix that error and want to find
out if the compiler will accept the fix. But if you just do a make or compile
again, you will lose your earlier warning messages, which you may yet
want to look at. How can you avoid this? All you have to do is to turn on
the Keep Messages toggle in the Options/Environment menu.

When the Keep Messages toggle is set to On, messages are not cleared out
when you start up a make. The only messages removed are the ones that
result from the files you recompile. Thus, the old messages for a given file
are replaced with any new messages that the compiler may generate.

If at some point you are done with the messages, you can get rid of them by
choosing Project/Remove Messages. This zaps all the current messages.
Setting Keep Messages to Off and running another make will also get rid of
any old messages.

It's a good idea to get into the habit of clearing the messages when you
change projects. To facilitate this, there is a shortcut in the Project menu,
called Clear Project, that clears both the project name and the current
messages. After choosing Project/Clear Project, you can define a new
project or compile and run single-file programs by simply loading them
into the editor or defining the primary .C file name with the Primary C File
command.

The Power of Project-Make

In the last description of making a project, you dealt with the most basic
situation: just a list of C source file names. Project-Make provides a lot of
power to go beyond this simple situation. To see this you need to under-
stand how a make works.

A make works by comparing the date of the source file with the date of the
object file generated by the compiler. This comparison of creation dates
defines several implicit dependencies in a simple project list.
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Given the earlier example using MYPROG.PR], you have the following de-
pendencies:

MYMAIN.OB] is dependent on MYMAIN.C

MYFUNCS.OB] is dependent on MYFUNCS.C

MYPROG.EXE is dependent on MYMAIN.OBJ], MYFUNCS.OB]J, and
MYPROG.PR]

This means the object file MYMAIN.OBJ is out-of-date if MYMAIN.C is
newer than MYMAIN.OBJ; thus MYMAIN.C will be recompiled. Notice the
executable file is always dependent on all object files in the project and on
the project file itself. This means that, if any of the objects or the project file
MYPROG.PR] itself has a newer date than MYPROG.EXE, the make will
relink MYPROG.EXE. These implicit dependencies arise from the simple
list of file names of the C files in your project.

Explicit Dependencies

However, bigger projects require a more sophisticated make facility that
allows you to specify explicit dependencies. This is useful when a partic-
ular C source file depends on other files. It is common for a C source to
include several header files (.h files) that define the interface to external
routines. If the interface to those routines changes, you would like the file
that uses those routines to be recompiled. This is done with explicit depen-
dencies.

For example, say you have a main program file, MYMAIN.C, that includes
a header file MYFUNCS.H. A make will recompile MYMAIN.C and
MYFUNCS.C if MYFUNCS.H changes—if you specify the following depen-
dencies in your project file:

MYMAIN.C (MYFUNCS.H)
MYFUNCS  (MYFUNCS.H)

Notice that this project file makes the MYFUNCS.C file dependent on the
MYFUNCS.H file. This is a good consistency check for your files. So now
you have the same implicit dependencies as well as some explicit depen-
dencies, like so:

MYMAIN.OBJ] is dependent on MYMAIN.C and MYFUNCS.H

MYFUNCS.OBJ is dependent on MYFUNCS.C and MYFUNCS.H

MYPROG.EXE is dependent on MYMAIN.OBJ, MYFUNCS.OBJ, and
MYPROG.PR]

Any C file listed in a project file can have as many explicit dependencies as
it needs. Simply place the files you want the C source to be dependent on in
parentheses, separated by blanks, commas, or semicolons.
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For example if you want MYMAIN.C to be dependent on MYFUNCS.H,
YOURS.H, and OTHER.H, you would type

MYMAIN.C (MYFUNCS.H, YOURS.H, OTHER.H)

Note: When autodependency checking is on, any included file will be
checked, but explicit dependencies will not.

Autodependency Checking

Project-Make has the capacity for automatically checking dependencies
between source files in the project list and their corresponding object files.
Project-Make opens the .OB]J file and looks for information about files
included in the source code. This information is always placed in the .OB]J
file by both TC and TCC when the source module is compiled. Then every
file that was used to build the .OB] file is checked for time and date against
the time/date information in the .OBJ file. The .C source file is recompiled
if the dates are different.

Note: In order for this feature to work, you must toggle On the Project/
Auto Dependencies switch in the integrated environment.

That is all there is to dependencies. This method gives you the power of
more traditional makes without all the hassle of a complicated make
syntax.

What? More Make Features?

There are two other features that add to the power of the make:

myou can specify external object and library files to be linked into your
project
® you can override the standard startup files and libraries

External Object and Library Files

From time to time, you might want to use some routines that came from
another source, such as assembly language or another compiler. Or maybe
you have some library files that perform special functions not provided in
the standard libraries.
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In these cases, you can include the name of the object or library files in your
project with an explicit extension, like this (note that, when listing files, the
order is not important):

MYMAIN (MYFUNCS.H)
MYFUNCS (MYFUNCS.H)
SPECIAL.OBJ
OTHER.LIB

When Project-Make sees a file with an explicit .OB]J extension, it simply
includes that file in the list of files to be linked together. It does not try to
compile it or find its source, or read in autodependency information.
Similarly, a name in your project file with a .LIB extension gets put into the
list of libraries the linker searches when trying to resolve external
references. Again, it does not try to compile or build the library.

Note that files of these types cannot have explicit dependency lists (they
will be ignored). However, you can include these names in your C source
dependency list like any other file you want your source to depend on.

For example,

MYMAIN (MYFUNCS.H, SPECIAL.OBJ)
MYFUNCS (MYFUNCS.H, OTHER.LIB)
SPECIAL.OBJ

OTHER.LIB

What this means is that, if for some reason these .OB]J or .LIB files become
updated, the C source will be recompiled.

Overriding the Standard Files

In some cases, it is necessary to override the standard startup files or
libraries. This is usually recommended only for experienced users, and is
not a common practice for beginners. But if you ever feel the need, here’s
how to do it.

To override the startup file, you must place a file called C0x.OBJ as the first
name in your project file—where x stands for any DOS name (for example,
COMINE.OBJ). What is critical is that the name start with C0, that it is the
first file in your project, and that it have an explicit .OB]J extension.

To override the standard library, all you need to do is place a special library
name anywhere in the list of names in your project file. The name of the
library must start with a C, followed by a letter representing the model
(such as s for the small model); the remaining characters, up to six, may be
anything you want for a file name. You must use an explicit .LIB extension
(for example, CSMYFILE.LIB or CSNEW.LIB).
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When the standard library is overridden, make does not try to link in the
math libraries as based on the Floating Point toggle setting in the O/C/
Code Generation menu. If you wish to have these libraries linked in when
you override the standard library, you must explicitly include them in your
project file.

Compiling and Linking from a Command
Line

In addition to using the integrated development environment, you can run
your Turbo C programs with the old-fashioned type of command-line
interface. While the integrated development environment mode is best for
developing and running your programs, you may sometimes prefer to use
the command line; in some advanced programs, the command-line
interface may be the only way to do something intricate. For example, if
your Turbo C programs include inline assembly code, you will need to use
the command-line version of Turbo C (TCC) rather than TC, the integrated
development environment version.

TCC compiles C source files and links them together into an executable file.
It works similarly to the UNIX CC command. TCC will also invoke TASM
to assemble .ASM source files. Note that to compile only you have to use the
-c option at the command line.

The TCC Command Line

To invoke Turbo C from the command line, enter TcC at the DOS prompt
and follow it with a set of command-line arguments. Command-line
arguments include compiler and linker options and file names. The generic
command-line format is

tcc [option option option ...) filename filename ...

Options on the Command Line

Each command-line option is preceded by a hyphen (-) and separated from
the tcc command, other options, and following file names by at least one
space. You can explicitly turn a command-line option off by following the
option with a dash. (For example, -k- explicitly turns the unsigned chars
option off.) Turbo C’s command-line options are described in Appendix C
of the Turbo C Reference Guide.
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File Names on the Command Line

After the list of options, type file names on the command line. The compiler
compiles files according to the following set of rules:

filename compile filename.c

filename.c compile filename.c

filename.xyz compile filename.xyz
filename.obj include as object at link time
filename.lib include as library at link time
filename.asm invoke TASM to assemble to .OBJ

The compiler will then invoke the linker and supply the linker with the
names of the appropriate C startup file and standard C libraries.

The Executable File

Normally, the compiler derives the name of the executable file from the first
source or object file name supplied on the command line. The executable
program is given that first file name with the .EXE extension.

If you want to specify a different name for the executable file, use the -e
option. After the tcc command and before any file names, enter -e imme-
diately followed by the name you want to give the executable file (no
whitespace between the e and the file name).

Some Sample Command Lines

The following example illustrates proper syntax for invoking Turbo C from
the DOS command line:

tce -IB:\include ~LB:\1lib -etest start.c body.obj end

For this example command line, the command tcc invokes Turbo C at the
DOS prompt. Turbo C then interprets the command-line options as
meaning
u The include directory is B:\INCLUDE (-1B:\include).
s The libraries are in the B:\LIB directory (-LB:\1ib).
@ The executable result should be placed in a file called
TEST.EXE (-etest).
Turbo C interprets the listed files to mean that this program consists of

= a source file called START.C to be compiled
m an object file called BODY.OB]J to be included at link time
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m another source file called END.C to be compiled
Here is another example of a Turbo C compile-time command line:
tec -IB:\include -1B:\lib2 -mm -C -K sl s2.c z.asm mylib.lib

This compile-time command line directs Turbo C to

m look for the include files in the B:\INCLUDE directory (-IB:\include)
m look for the libraries in the B:\LIB2 directory (~LB:\1ib2)

m use the Medium memory model (-mm)

m allow nested comments (-C)

= make chars unsigned (-K)
Turbo C interprets the list of file names to mean

& The source files called $1.C and S2.C are to be compiled.

m The file Z.ASM is to be assembled (using TASM).

m The executable file will be named S1.EXE.

m The library file MYLIB.LIB is to be linked in at link time

The TURBOC.CFG File

You can set up a list of options in a configuration file called TURBOC.CFG,
which can be used in addition to options entered on the command line.
This configuration file contains options as they would be entered on the
command line.

If you've listed your commonly used options in TURBOC.CFG, you won’t
need to enter them on the command line when you use TCC.EXE. If you
don’t want to use certain options that are listed in TURBOC.CFG, you can
override them with switches on the command line.

You create the TURBOC.CFG file using any standard ASCII editor or word
processor (such as the Turbo Editor in the integrated development envi-
ronment version). You can list options (separated by spaces) on the same
line or list them on separate lines. Then, when you compile your program
from the command line, Turbo C uses the options supplied in
TURBOC.CFG, in addition to the ones given on the command line.

When you run TCC, it looks for TURBOC.CFG in the current directory. If it
doesn’t find it there and if you're running DOS 3.x, it then looks in the start
directory (where TCC.EXE resides). Note that TURBOC.CFG is not the
same as TCCONFIG.TC, which is the default integrated development envi-
ronment version of a configuration file.
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Options given on the command line override the same options specified in
TURBOC.CFG. This ability to override configuration file options with com-
mand-line options is an important one. If, for example, your configuration
file contains several options, including the -a option (which you want to
turn off), you can still use the configuration file but override the -a option
by listing -a- in the command line.

How are command-line options and TURBOC.CFG options combined and
overridden? There are two kinds of TURBOC.CFG options:

m the -1 and -L options
m all the other options in the file

Under any circumstances, command-line options are evaluated from left to
right, and the following rules apply:

m For any option that is not an -I or -1 option, a duplication on the right
overrides the same option on the left. (Thus an off switch on the right
cancels an on switch to the left.)

m The -1 and -L options on the left, however, take precedence over those on
the right.

When the options from the configuration file are combined with the com-
mand-line options, the -I and -L options from TURBOC.CFG are appended
to the right of the command-line options, and the remaining TURBOC.CFG
options are inserted on the left of the command line’s list of options, imme-
diately after the tcc command.

Thus, because of the way the command line and TURBOC.CFG are com-
bined, the TURBOC.CFG -I and -1 options are on the extreme right, so the
include and library directories specified in the command line are the first
ones that Turbo C searches for the include and library files. This gives the
-I and -1 directories on the command line priority over those in the config-
uration file. All other options from the TURBOC.CFG file are inserted to the
left of the command-line options, which again, correctly, gives the com-
mand-line options priority over them.

The TCCONFIG.EXE Conversion Utility for Config-
uration Files

The integrated environment and command-line compiler have a number of
common options, listed in Table C.1 of Appendix C in the Turbo C Reference
Guide, “TCC Command-Line Options.” TCCONFIG.EXE takes a config-
uration file created by one environment and converts it for use by the other.
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The conversion command is
TCCONFIG SourceFile (DestinationFile]

TCCONFIG automatically determines the direction of the conversion: It
examines the source file to see whether it is an integrated environment (TC)
configuration file or a command-line compiler (TCC) configuration file.

The destination file name is optional. If you don’t specify a file name,
TCCONFIG uses the default name TCCONFIG.TC or TURBOC.CFG, de-
pending on the conversion direction. You can give any file name; the com-
mand-line compiler, however, only looks for a file named TURBOC.CFG
when it runs. It won’t run on any other name.

When it creates the TCCONFIG.TC file, TCCONFIG uses default values for
any items not specified by the command-line compiler configuration file
(TURBOC.CFG). Going in the other direction, it includes in TURBOC.CFG
only the options in TCCONFIG.TC that differ from the default values.

TCCONFIG returns you to the DOS prompt when the conversion is done.

The MAKE Utility

Turbo C’s stand-alone MAKE utility, a more powerful version of Project-
Make, permits you to describe source and object file dependencies. It is
based on the UNIX MAKE utility. The MAKE utility evaluates those depen-
dencies to ensure that the files are correctly compiled and linked.

What is the advantage to using a MAKE utility? As with Project-Make, you
do not have to keep track of which program components have changed
since you last compiled them. Stand-alone MAKE is more powerful than
Project-Make, however, because it is a general-purpose program builder.
Before linking your complex program’s object files, MAKE recompiles any
files that need to be updated. Then it simply incorporates the newly
compiled files with those that did not need to be recompiled and creates a
new, executable program file.

Appendix D in the Turbo C Reference Guide contains a detailed explanation
of the stand-alone MAKE utility.

BUILTINS.MAK

BUILTINS.MAK is an optional file in which you can store MAKE macros
and rules that you use again and again, so you don’t have to keep typing
them into your makefiles. See Appendix D of the Turbo C Reference Guide
for information on how to write makefiles and set up a BUILTINS.MAK
file.
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Running Turbo C Programs from the DOS
Command Line

To run executable Turbo C programs from the DOS command line, simply
type the executable file name at the DOS prompt. It is not necessary to
include the .EXE extension. For example, to execute the program TEST.EXE,
you would just type test at the DOS prompt and press Enter. The TEST pro-
gram would then run (execute).

Moving Ahead with Turbo C

Now that you have seen how to compile, link, run, and make your Turbo C
programs, both with the integrated development environment and through
standard command lines, you are ready to put Turbo C through its paces.
As you expand your knowledge about the language and about this imple-
mentation, you will want to refer to the second volume of this handbook,
the Turbo C Reference Guide, for information about the run-time envi-
ronment, the library files, and Turbo C’s implementation of the C language,
as well as a number of useful stand-alone utilities included with Turbo C to
make your job easier. Check out Chapter 4 for a guided tour of Turbo C’s
integrated debugger, Chapters 6 and 7 for an overview of the C
programming language, Chapter 8 for an introduction to the Turbo C
graphics functions, and Chapter 12 on advanced programming techniques.

If you know Turbo Pascal or Turbo Prolog, you will also want to read
Chapters 9 and 10, respectively, for some tips on how to use either of these
languages with this fast, powerful C programming package.
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Debugging Your Program

When you first run a program after correcting compile and link errors, it
still is not likely to work correctly. A new program almost always contains
numerous bugs—errors in design and coding—that you must identify and
fix. Finding and fixing a program’s bugs is called debugging.

It’s hard to find bugs merely by watching the afflicted program’s behavior,
$0 most programmers use a debugger to help them locate the bugs in their
programs. A debugger is a piece of software that lets you take control of
your program as it runs. You can stop your program’s execution at any
point, run it one statement at a time, and inspect the data it is processing.

In This Chapter...

Turbo C’s integrated environment contains a debugger, called the
integrated debugger. In this chapter, we explain how to use the Turbo C
integrated debugger.

The chapter begins with a series of examples that demonstrate how to use
the integrated debugger. In the first example, we show you how to use the
debugger’s simplest features to identify an “easy” bug. The following
examples illustrate more advanced features of the debugger.

There follows a survey of the debugger menu commands and related menu
commands, with the corresponding hot keys or hot key combinations, and
a description of what each command does.

Finally, we present some guidelines that will make debugging easier for
you. Many of the guidelines concern how to design and write a program, as
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well as how to debug one. You can apply most of these ideas to any
computer language, not just to Turbo C.

How the Integrated Debugger Works

Turbo C’s integrated debugger is a source-level debugger. This means that
you control the debugger with the same “language” you use to write your
programs. For example, you might display the value of an element in an
array by telling the debugger to display the value of an expression like

rptr->image[nptr+0x80]

You debug a program simply by running it with the Run/Run menu option
(hot key: Ctrl-F9). The debugger takes over if the program was compiled
with the Source Debugging toggle set to On. (To set this toggle, choose
Debug/Source Debugging.)

Before you run the program, you can set breakpoints on one or more lines
in the source file. When the running program encounters a breakpoint, it
halts just before executing the first statement on the line bearing the
breakpoint and returns control of the debugger to you.

While the program is halted, you can study and manipulate it in many
ways. For example, you can
= display the value of a variable or expression

mset up a list of expressions in a special window and observe how their
values change

m change the value of a variable
m clear existing breakpoints or set new ones
m run the program one line at a time

m edit files, recompile and relink the program, or use any other feature of
Turbo C’s menu system

mmake the program continue running until it encounters another
breakpoint

Figure 4. illustrates the typical course of a debugging session. (Note that it
doesn’t show everything you can do with the integrated debugger at each
step.)
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Example 1: Debugging a Simple Program

For your first debugging experience with Turbo C, you'll use the program
shown in the following example. We'll refer to this program as WORDCNT.
It is meant to display the contents of a text file and tabulate word lengths;
that is, report how many words are one character long, how many are two
characters long, and so forth. Unfortunately, WORDCNT contains several
bugs. You're going to use the debugger to find them.

You'll find WORDCNT in the file WORDCNT.C on one of the distribution
disks. Copy it into your Turbo C directory so you'll be sure to have a fresh,
buggy version!

If you're working in a directory other than the one that contains Turbo C,
make a working copy of WORDCNT.C. Also make a working copy of the
data file WORDCNT.DAT. Both files are on the distribution disks and in
your Turbo C directory.

/tt*t*

Read a text file; count the number of words of length 1, 2, 3, etc.

in the debugging chapter of the User’s Guide. It

*

*

* NOTE: This program is for use with the debugging tutorial
*

* intentionally contains bugs.

finclude <stdio.h>
$include <ctype.h>

§define MAXWORDLEN 16

§define NUL {(char)0)

fdefine SPACE ((char)0x20)
/ttt*t

* Find the next word in the line buffer.
* IN: wordptr points to the first character of a word or a preceding
* space.

* RETURN: A pointer to the first character of the word. If there are no
*

more words, a pointer to the terminating NUL.
ttttt/

char *nextword{char *wordptr)
{
/* Advance to the first non-space. */
while ( *wordptr==SPACE )
wordptrt+;
return{wordptr);
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/iitit

* Find the length of a word. A word is defined as a sequence of characters
* terminated by a space or a NUL.

* IN: wordptr points to a word.
* RETURN: The length of the word.
**ti*/

int wordlen(char *wordptr)
{

char *wordlimit;

wordlimit = wordptr;

while ( *wordlimit & *wordlimit!=SPACE )
wordlimit++;

return( wordlimit-wordptr );

}

/**t*t

* The main function.
tt***/

void main(void)
{

FILE *infile; /* Input file, */

char linebfr(1024]), /* Input line buffer, very long for safety. */
*  wordptr; /* Pointer to next word in linebfr, */

int i; /* Scratch variable, */

static int wordlencnt [MAXWORDLEN],
/* Word lengths are counted in elements 1 to
MAXWORDLEN. Element 0 isn’t used. The array is
static so that the elements need not be set to
zero at run time. */
overlencnt; /* Overlength words are counted here, */

printf(" WARNING: This is an example program for the practice\n®);
printf(" debugging session. If you are not running this under the.\n");
printf("Integrated Development Environment, press control-break now.\n"):
printf("See the debugging chapter of the User’s Guide for details.\n\n");

printf( “Enter the input file’s name: " );
gets(linebfr);
if ( !strlen(linebfr) ) {
printf{ "You must specify an input file name!\n" );
exit();
}
infile = fopen( linebfr, "r" );
if ( linfile ) {
printf({ "Can’t open input file!\n" );
exit();
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/* Each loop processes one line. NOTE: If a line is longer than the
input buffer,the program may produce invalid results., The very large
buffer makes this unlikely. */
while ( fgets({ linebfr, sizeof(linebfr), infile ) ) |

printf("%s\n”,linebfr);
/* Check for buffer overflow & remove the trailing newline. */
i = strlen(linebfr);
if ( linebfr(i-1] != *\n’ )
printf( “Overlength line beginning\n\t$70s\n”, linebfr };
else
linebfr(i~1] = NUL;

/* lineptr points to the 1lst word in linebfr (past leading spaces). */
wordptr = nextword(linebfr);

/* Each loop processes one word. The loop ends when [nextword]

returns NULL, indicating there are no more words. */

while (*wordptr) {

/* Find the length of this word, increment the proper element of the
length count array, and point to the space following the word. */
i = wordlen (wordptr) ;
if ( i > MAXWORDLEN )

overlencnt++;

else

i
wordlencnt [1]++;
wordptr += i;
/* Find the next word (if any). */
wordptr = nextword (wordptr);

}
}

/* Print the word length counts. Each lcop prints one. */
printf( * Length Count\n® );
for ( i=1; i<MAXWORDLEN; i++ )
printf( * %5d $5d\n®, i, wordlencnt(i] );
printf( "Greater %5d\n", overlencnt );

/* Close the file and quit. */
fclose(infile);
)

Be sure the Debug/Source Debugging and O/C/C/OB] Debug
Information toggles are both set to On. Start up TC by typing

TC WORDCNT

at the DOS prompt. Build the program (choose Compile/Build All). Turbo
C will compile and link WORDCNT, prepare it for execution, and then halt.
Now choose Run/Trace Into (or press F7).

At this point, the debugger has scrolled the beginning of main into the Edit
window. It has highlighted the line containing the declaration of the main
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function (void main (void)), indicating that this will be the first line to be
executed when you run WORDCNT. This highlight is called the execution
bar, and it marks the execution position: the line containing the next
statement to be executed.

To make WORDCNT run, choose Run/Run. WORDCNT prompts you to
enter the name of an input file. Type WORDCNT.DAT and press Enter.
WORDCNT should read and display the first line of the data file, then lock
up your computer, because of the bugs in the program. Enter Ctrl-Break to
unlock it, and press Esc to verify. Then choose Run/Program Reset (or
press the hot key, Ctrl-F2) to end the debug session and press F7 (Run/Trace
Into) to start a new one.

Setting and Using a Breakpoint

As the source file comments explain, the first part of main prompts for the
input file’s name and opens the file. The fact that WORDCNT read and
displayed the first line of the input file suggests strongly this part of the
code is working—well enough, at least, not to be responsible for the
malfunction we’ve observed. Therefore, you can run through the first part
of main and stop when you reach the suspicious part. To accomplish this,
you must set a breakpoint on the line where you want to stop.

Use PgDnand Down arrow to move the cursor to the line that begins
while ( fgets( ....

(It’s just below the long comment that begins Each loop processes....)
Notice that the execution bar doesn’t move. That’s because you aren’t
running statements in the program; you’re just moving the editor’s cursor.

To set a breakpoint on the line at the cursor, choose Break/Watch/ Toggle
Breakpoint (or its hot key combination, Ctri-F8). The debugger will highlight
the line to indicate that a breakpoint is set there. Notice that the appearance
of this breakpoint highlight is different from the appearance of the
execution bar.

Now choose Run/Run (or its hot key combination, Ctr-F9). WORDCNT will
continue (in this case, start) running.

After WORDCNT prompts you to enter the name of an input file, it will
halt and wait for keyboard input. The debugger shows you what
WORDCNT wants by displaying the Execution screen, which shows the
program’s output just as if the program were running without the
debugger. Type WORDCNT.DAT and press Enter. WORDCNT will continue
running until it encounters the breakpoint; then it will stop and the Edit
window will reappear. The cursor and the execution bar are now on the
while statement.
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Note that the breakpoint you set on the while statement is still there. You
can’t see it because the execution bar obscures it, but it will reappear when
the execution bar moves on. WORDCNT will stop every time it reaches this
breakpoint until you toggle the breakpoint off.

Using Cirl-Break

In addition to any breakpoints you might set, you also have an “instant”
breakpoint during execution: pression Cir-Break. This means that, barring a
major crash, you can interrupt your program at any time. When you press
Ctrl-Break, you drop out of your program and back into the TC Editor, with
the execution bar on the next line to execute and ready to step through the
rest of the program. A prompt appears, telling you to press Esc to verify the
break:

|| User break in ;BE'DC%.C. Press ESC. "

What actually happens is that the debugger is in contact with DOS, the
BIOS, and other services, and so it knows whether the code currently
executing is a DOS routine, a BIOS routine, or the program itself. When you
press Ctrl-Break, the debugger waits until the program itself is executing.
Then it starts stepping every machine-level instruction until it comes to one
at the beginning of a C source code line. At that point it breaks, so that the
execution bar is on that line of code.

If a second Ctrl-Break is detected before the debugger locates and displays
the source code line, the debugger terminates the program immediately
and doesn’t try to find the line of source code. In such a case, the program
terminates without flushing any output or calling any exit functions. (This
is similar to terminating via the _exit function.) Therefore, you should press
Ctrl-Break twice only when your program is stuck in an infinite loop and one
Ctrl-Break doesn’t abort it.

Stepping Over Function Calls

Now that you've reached a part of WORDCNT where a bug may be, you
must proceed more cautiously. Run the next part of main one line at a time,
pausing after each line to see whether it has had the desired effect.

To run one line of main, choose Run/Step Over. The debugger will run the
while statement and read the first line of input. Then it will move the
highlight down to the next line containing executable statements. Choose
Run/Step Over again to run the following call to printf.
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Did the while statement have the desired effect? To find out, select User
Screen from the Run menu, or press Alt-F5. This command displays the
Execution screen. You can see the first line of input on the screen, so you
may conclude that both the while and the printf worked correctly. Press
any typing key to redisplay the Edit window.

The debugger has a hot key for Run/Step Over; it is F8. Press F8 now to
execute the next statement, which computes the length of the input line and
assigns it to the variable i.

Warning! Tracing into or stepping over a call to the library function
longjmp will not stop at the next line (because that function never returns).
It will cause your program to run to the next breakpoint or to completion.

Evaluating an Expression

Did the assignment statement have the desired effect? You can find out by
displaying the value of i.

Choose Debug/Evaluate. The debugger opens a pop-up window
containing three fields. We'll refer to these fields by their functions:

1. The Evaluate field: Here you enter the expression you want to evaluate
and possibly modify. (Note: If the expression you enter is too long for
the Expression field box, you can scroll the expression using Right amow,
Left arrow, Home, and End.)

2. The Result field: Here the debugger displays the expression’s value.

3. The New Value field: Here you enter the new value you want the
expression to have (optional).

Notice that the Evaluate field contains a word. This is the field’s default
value, copied from the word at the cursor in the Edit window. We'll
consider its uses in a moment. For the present, type the expression i in its
place, and press Enter. The debugger displays the value of i in the Result
field. It is 43, which is correct. Press Esc to escape from the menu system.

The next group of statements checks whether the line read by fgets ends
with a newline character. If it doesn’t, the input line was too long to fit in
the buffer, and the program displays a warning message. If the line does
end with a newline character everything is OK; the program removes the
newline from the string so that it won’t be counted as a character in the last
word.

Before you execute the if statement, it is helpful to display the input line to
see what result you should expect. Move the cursor to an occurrence of the
word linebfr in the Edit window, and choose Debug/Evaluate (or its hot
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key combination Ctrl-F4) again. The debugger displays linebfr in the Debug/
Evaluate window’s Evaluate field. Press Enter.

The debugger should display
To be or not to be: that is the question.\n
\n represents a newline character, just as it does in a C source program.

Now run the if statement by choosing F8. The execution bar moves to the
else clause, so the if statement did the right thing. Run the assignment
statement in the else clause, then evaluate linebfr again. (You can use the
hot key Ctrl-F4 for Debug/Evaluate.) The newline character (\n) has been
removed. So far, so good.

The nextword and wordlen Functions

The next statement calls nextword, a function that locates the next (in this
case, the first) word in a string. Run this statement using F8 and evaluate
wordptr to see what value nextword returned. You should find that wordptr
points to the T in To be or not to be: that is the question. If it does,
nextword is functioning correctly, at least in this simple case.

Next the program enters a while loop. Each iteration of the loop should
process one word in linebfr, then advance wordptr to the next word. After
the loop has processed the last word, wordptr should be pointing to the null
character that terminates the line, and the loop should end.

Run the while statement. The execution bar moves to the first statement in
the body of the loop, which calls the function wordlen. This function
determines the length of the word at wordptr. Run the statement and
evaluate i. The value of i is 0, which is not correct; the length of the first
word on the line should be 2. We’ve found a bug!

Stop and Think

Before you rush off to fix the bug, though, it’s worth your while to consider
its effect on the program. An erroneous word length of 0 will have two
effects. First, it will increment the wrong element of wordlencnt, element 0.
Second, it will cause the statement wordptr += i to leave the value of wordptr
unchanged. That, in turn, will make the second iteration of the while loop
begin with the same value of wordptr as the first. Since wordlen returned 0
the first time it was called, it presumably will return 0 the second time, too.
Thus the value of wordptr will be the same the third time through the while
loop, and the fourth time, and so on, forever. That fits the observed
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behavior of WORDCNT perfectly. This bug is the one that makes
WORDCNT lock up your computer.

What was the point of this exploration? You might have found that the bug
explained only part of WORDCNT’s misbehavior, or that it wasn’t related
to the misbehavior at all. In either case, you'd probably want to run more of
the program to see what would happen next. As it is, you can concentrate
on fixing the bug you've found with a high degree of confidence that the
program’s behavior will be corrected, or at least improved.

What You’ve Accomplished

You've found that WORDCNT is misbehaving because of a bug in wordlen.
You still must find out exactly what is wrong with wordlen. We'll return to
that in a moment. First, we'll take some time out to review the debugger
commands you've used, and to learn more about them.

In your first effort at debugging WORDCNT, you have done the following
things:

mensured that the Debug/Source Debugging and O/C/C/OB] Debug
Information toggles are set to On

m selected Compile/Build All to prepare WORDCNT for debugging

mused editor commands to move the cursor to the suspicious part of
WORDCNT; selected Break/Watch/Toggle Breakpoint to set a
breakpoint there; selected Run/Run (or its hot key combination Ctr-F9) to
run WORDCNT up to the breakpoint

mused Run/User Screen or its hot key Alt-F5 to inspect your program
output on the User screen.

m selected Run/Step Over (or pressed its hot key, F8) to run the statements
in main, one line at a time

m selected Debug/Evaluate (or pressed its hot key command, Ctrl-F4) to
display the values of several variables

= thought about the bug you found, and concluded that it explains
WORDCNT’s observed misbehavior and so warrants immediate
correction

The Default Expression in the Evaluate Window
Recall that Debug/Evaluate copies the word at the cursor in the Edit
window into the Evaluate field. You can often save work by putting the

cursor at a variable you want to evaluate before you choose Debug/
Evaluate. Even if the expression you want is different, you may be able to
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enter it more quickly by editing the default expression than by typing it in
from scratch. Furthermore, you can copy more text from the Edit window
to the default expression by pressing Right amow. Each time you press Right
amow, it copies one additional character.

For example, suppose you want to evaluate the expression linebfr[i-1],
which appears in the source file in the line

if ( linebfr(i-1) != ’\n’ )

Move the cursor to linebfr and choose Debug/Evaluate. The Evaluate field
displays the default expression linebfr. Press Right arrow five times to append
[i-1] to the expression. Then press Enter.

Changing the Value of an Evaluated Expression

Debug/Evaluate can change the values of some types of expressions. It can
change the value of any expression that represents a single data element,
such as i, linebfr(il, or *(linebfr+i).

Try evaluating the variable i and then changing its value. When you press
Enter to evaluate i, the debugger displays the value of i in the Result field.
Go to the New Value field (use Down arow) and specify the value you want
to assign to i. For example, you can edit the New Value field to say i+l (to
increment i by 1), or type in 17. When you press Enter, the debugger
evaluates what you entered, changes the value of i, and displays the new
value in the Result field. (Note: Remember, once you have pressed Enfer in
the New Value box, the value of the variable being evaluated changes, and
pressing Esc will not undo the change.) Press Esc to leave Debug/Evaluate,
invoke the command again, and redisplay the value of i to confirm that it
has been changed. Then change it back and leave Debug/Evaluate again.

You can modify the value of an expression to correct the effects of a bug,
letting you run your program somewhat further in order to find additional
bugs. You can also use it to gain insight into your program’s behavior. For
example, suppose you want to see how a certain function behaves when it
is passed an invalid parameter value. It may be hard to make the program
pass the function that particular value, but you can often get the same
result by changing the value of some variable just before the program calls
the function.

If you leave the New Value field by pressing Esc instead of Enter, the
debugger does not change the expression’s value. Press Esc if you modify
the new value by accident, or modify it and then change your mind.

You can evaluate any legal C expression, provided it doesn’t contain
= function calls

54 Turbo C User’s Guide



mdefined or type-defined symbols or macros (*wordptr == 0x20 is OK;
*wordptr == SPACE is not OK, since SPACE is defined)

mlocal or static variables not in the scope of the function being executed,
unless they are fully qualified

Qualifying Variable Names

There are three typical situations where you may want to qualify a variable
name used in an expression.

u To examine static variables in another module, use:

|
.<module name>.<variable name>

u To examine local variables in a global function, use:

| |
<function name>.<variable name>

= To examine local variables in a static function use:

| ]
.<module name>.<function name>.<variable name>

For example, suppose your program contains two modules, FIRSTMOD
and MODULE2:

/* FIRSTMOD.C */
int a=1;
main()
{
int b=2;
myfunc();
printf("sd*, i);
}

/* MODULE2.C */
static int e = 3;
static void localfunc(void)
{
int d = 4;
printf("End of the road\n®);
)
void myfunc(void)
{
int ¢ = 5;
localfunc();
}

To watch the global variable g, simply use:

a
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To watch the local variable b in function main use:
main.b
To watch the local variable ¢ in function myfunc use:
myfunc.c
To watch the local variable d in the static function localfunc, use:
.module2.localfunc.d
To watch the static variable e in MODULE2, use:
.module2.e

The need for qualifiers depends on the current instruction pointer. If your
program is running in main, there’s no need to qualify the variable b with
the function bane main. Likewise, if your program is running inside the
MODULE2 module, it is not necessary to qualify the variable e with the
module name.

It’s not possible to watch an auto (local) variable in an inactive scope. Since
the function myfunc calls localfunc, it is possible to watch the local
variables of myfunc from localfunc;

the variables in myfunc are not removed when localfunc is called.
However, once myfunc returns to main, you can no longer view its local
variables. Variables local to a function are discarded when the function
returns to its caller.

Format Specifiers

To control exactly how information is displayed in the Debug/Evaluate
window, Turbo C allows you to add optional format specifiers to expressions
in the Evaluate field (the same is true for the Watch window). A format
specifier follows the expression, separated from it by a single comma. It
may be either upper or lowercase.

A format specifier consists of an optional repeat count (an integer), followed
by zero or more format characters; no spaces are required between the repeat
count and the format characters. Table 4.1 lists the available format
characters, and describes their effect.

The repeat count is used to display consecutive variables, a typical example
of which is the elements of an array. For example, if list is an array of 10
integers, the expression 1ist would display

list: ( 10, 20, 30, 40, 50, 60, 70, 80, 90, 100 }

If you want to look at a particular range of the array, you can specify the
index of the first element you want to examine, and add a repeat count:
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list(5),3: 60, 70, 80

This technique is particularly useful for dealing with arrays that are too
large to be displayed completely on a single line.

Repeat counts aren’t limited to arrays; any variable may be followed by a
repeat count. The general syntax var,<n> simply displays n consecutive
variables of the same type as var, starting at the address of var. Note
however, that the repeat count is ignored if your expression is not
equivalent to a variable. A good rule of thumb is that a given construct is a
variable if it can legally appear on the left hand side of an assignment
statement, or if it can be used as an argument to a function.

Table 4.1: Debugging Format Specifiers

Character

Function

C

HorX

F<n>

Character. Shows special disglay characters for control
characters (ASCII 0 through 31); for example, a ~C would
be displayed as a Happy Face. Affects characters and
strings.

String. Shows control characters (ASCII 0 through 31) as
ASCII values using the appropriate C escape sequences.
Since this is the default character and string display format,
the S specifier is only useful in conjunction with the M
specifier.

Decimal. All integer values are displayed in decimal.
Affects simple integer expressions as well as arrays and
structures containing integers.

Hexadecimal. All integer values are displayed in
hexadecimal with the 0x prefix. Affects simple integer
expressions as well as arrays and structures containing
integers.

Floating-point. n is an integer between 2 and 18 specifyin,
the nuﬁg\bgr of si%nificant d%gits to display. Affectspgnly 8
floating-point values.

Memory dump. Displays a memory dump, starting with
the address of the indicated expression. The expression
must be a construct that would be valid on the lefthand
side of an assignment statement, i.e. a construct that
denotes a memory address; otherwise, the M specifier is
ignored. By default, each byte of the variable is shown as
two hexadecimal digits. A ding a D specifier with the M
causes the bytes to be displayed in decimal, and adding an
H or X specifier causes the bytes to be displayed in
hexadecimal. A C or an S specifier causes the variable to be
displayed as a string (with or without special characters).
The default number of bytes displayed corresponds to the
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Table 4.1: Debugging Format Specifiers (continued)

size of the variable, but a regeat count may be used to
specify an exact number of bytes.

P Pointer. Displays pointers in seg:ofs format with additional
information about the address pointed to, rather than the
default hardware-oriented seg:ofs format. Specifically, it
tells you the region of memory in which the segment is
located, and the name of the variable at the offset address,
if that is appropriate. The memory regions are as follows:

Memory Region Evaluate Message

0000:0000 — 0CC0:03FF Interrupt vector table

0000:0400 — 00C0:04FF BIOS data area

0000:0500 - Turbo C MSDOS/TSR’s

Turbo C - User Program PSP Turbo C

User Program PSP User Process PSP

User Program - top of RAM  Name of a static user
variable if its address falls
inside the variable’s
allocated memory;
otherwise nothing

A000:0000 - AFFF:FFFF EGA Video RAM

B000:0000 ~ B7FF:FFFF Monochrome Display RAM

B800:0000 - BFFF:FFFF Color Display RAM

C000:0000 - EFFF:FFFF EMS Pages/Adaptor BIOS
ROM'’s

F000:0000 - FFFF:FFFF BIOS ROM’s

R Structure/Union. Displays field names as well as values,
suchas { X:1, Y:10, 2:5 }. Affects only structures and
unions.

Here are some general rules that apply to format specifiers:

1. A format specifier takes effect only if it is appended to a variable of the
appropriate type. Otherwise it is ignored.
Note that if the expression being evaluated causes multiple objects to be
displayed (for example, as in a structure), and you suffix the expression
with more than one format specifier, the appropriate format specifier
will be applied to each object. For example, if you enter struct,F5H to
display a structure containing integers and reals, integers will be
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displayed in hexadecimal (H) and reals in floating-point format to five
significant digits (F5).

2. If you enter more than one format specifier of the same type for an
expression, type-dependent priority determines which of the conflicting
specifiers will be used: The one with the highest priority is chosen. This
whole issue, of course, is really relevant only for structures and unions.
For simple variables and arrays of simple variables, you will typically
enter only one format specifier.

Table 4.2: Priorlty and Defaults in Format Specifier Classes
Specifiers in Order

Type of Priority Default

char CSHD S

unsigned char CSHD S

int HDC*S* D

unsigned int HDC*S* D

lon HDC*S* D

unsigned long HDC*S* D

char ptr CSPH S

other ptr PH P

enum HDC*S* D (followed by member

name)

float Fn F7

double Fn F15

long double Fn F18

array of char CSHD S

other array elements enclosed in braces {} and separated by
commas

structure R —_—

* character format specifiers will be accegted only for values that
fall within the appropriate range (-128 to 127 for signed types and 0 to
255 for unsigned types).

Note: The H format specifier used by itself with a pointer variable
displays the pointer as a hexadecimal integer value.

To demonstrate the use of format specifiers, assume that the following
structure and variables have been declared:

struct {
int account;
char name(10);
} client = { 5000, "Jones" }

int list(5] = {0,10,20,30,40};
char *ptr = list;
void main()

{
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Then, entering the following expressions in the Evaluate field will produce
the corresponding evaluation in the Result field:

Evaluate Result

list { 0, 10, 20, 30, 40 }

list([2},3 20, 30, 40

list(2],3x 0x14, Ox1E, 0x28

list,m 00 00 OA 00 00 14 0O 1E 00 28 00

ptr DS§:0198

ptr,p DS:0198 [_list)

*ptr,3 0, 10, 20

client { 5000, ®Jones\0\0\O0\O\0" }

client,r { account:5000, name:"Jones\0\0\0\0\0" )

Exercise 2: Finding the Bug in wordlen

Now let’s return to WORDCNT and find out what’s wrong with the
wordlen function.

It’s generally a good idea to see if you can figure out what’s wrong just by
studying the code. In fact, it’s often the quickest way to find a bug once
your attention has been drawn to the right place. But this time, please resist
the temptation and play along with these exercises.

If you're still in the debugging session you started in Exercise 1, cancel it by
choosing Run/Program Reset (or pressing its hot key, Ct-F2). This makes
Turbo C release any memory WORDCNT allocated, close the file it opened,
and end the current run of WORDCNT.

On the other hand, if you've left the integrated environment or used it to
run other programs since you completed Exercise 1, load WORDCNT.C
again. Then set a breakpoint on the while (fgets(... statement again.

Now choose Run/Run to start a new debugging session. Turbo C will
prepare WORDCNT for execution again. Turbo C lets the program run
until it stops at the breakpoint.

At the filename prompt, type in WORDCNT.DAT and press Enter.

Choose Run/Step Over to run WORDCNT up to the statement that calls
wordlen. Then choose Run/Trace Into (or use its hot key, F7) to make the
debugger go into wordlen, rather than run the statement that calls it.
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Run/Trace Into runs a program one line at a time, like Run/Step Over, but
it steps into function calls instead of over them. In this case, it leaves the
execution bar at the declaration of wordlen.

Study wordlen’s logic a moment. The function expects one parameter, a
pointer to a word in a line buffer, which it names wordptr. It assigns the
value of wordptr to a local variable, wordlimit. Then a while loop advances
wordlimit until it points at a space ending the word or the null character
ending the line. It returns the difference between wordlimit and wordptr as
the length of the word.

Run two lines to execute wordlen’s definition through the assignment
statement. You may use either Run/Trace Into or Run/Step Over; since
wordlen calls no lower functions, the two commands will have the same
effect.

Evaluate the string that wordlimit points to; it's the first line of input, as it
should be. Run the while statement. The execution bar should move to the
following line, which increments wordlimit. Instead it moves to the line after
that, which contains a return statement. This may be the bug you're looking
for.

Consider what will happen next. Since wordlimit has not been incremented,
the difference between wordlimit and wordptr is 0, and wordlen will return
0. This is the bug you're looking for. You’ve narrowed down the scope of
the bug from “something in wordlen” to “something in the expression of
wordlen’s while statement.” Once again, it’s worthwhile to look at the code
and see if you can deduce what’s wrong,

If you can’t, try evaluating the parts of the guilty expression to see how
they work together. You'll find that the value of *wordlimit is ASCII T. You
can’t evaluate *wordlimit = SPACE, since SPACE is a #defined symbol; but
you can evaluate *wordlimit != * ’ (the value of SPACE is ‘ ), and its value is
1 (true). The value of the whole expression ought to be true, and it's false.
Something’s wrong with the & operator.

In fact, & is the wrong operator. It is C’s bitwise and operator, which ands
each bit of one operand with the corresponding bit of the other. Since
*wordlimit != SPACE is always 0 or 1, *wordlimit & *wordlimit != SPACE is 0
whenever *wordlimit is even. The operator should be &&, which gives a
result of 1 whenever both of its operands are nonzero. (Try evaluating the
whole expression with one & and then with two to see the difference.)

(If you didn’t figure out the problem yourself, don’t feel bad. Confusing &
with && and | with || is one of the most common errors novice C
programmers make. After you've found this error in your own code a few
times, you'll learn to recognize it readily.)
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Fixing the Bug

To fix the bug, all you need to do is change the & to &&. Save the corrected
program file (press F2) to protect yourself from losing the change you made
if your program should crash during a subsequent debugging session.
Then choose Run/Run again. Since you have modified the source code,
you will be asked if you want to rebuild. Press Y, and the program will
compile and link. Presto, you're ready to debug the corrected program.

We'll go hunting for more bugs after another brief time-out to summarize
what you’ve learned and take a closer look at some of the features you've
encountered.

What You've Accomplished

You have cancelled your first debugging session with Run/Program Reset
or its hot key, Ctrl-F2. Then you ran WORDCNT up to the call to wordlen by
setting a breakpoint there and choosing Run/Run (or its hot key
combination Cir-F9).

You traced into the call to wordlen with Run/Trace Into (hot key F7). That
let you step through wordlen and find the bug. You fixed the bug, saved
the source file, and prepared the updated program for debugging with
Run/Run.

More about Breakpoints

If you didn’t leave Turbo C after working through the first exercise, the
breakpoint you set at while ( fgets(... was still set when you started the
second one. That’s why Run/Run let WORDCNT run to the breakpoint
instead of running to the end of the program. As you can see, breakpoints
“stick” from one debugging session to the next. This is so even if you edit
and remake your program in between. Turbo C moves each breakpoint up
or down to keep it on the right statement.

Breakpoints stick even if you set them in a program file, save the file, and
edit other files. You lose your breakpoints only when you:

u leave the integrated environment

m delete the lines they are set on in the source file

m clear them all by choosing Break/Watch/Clear All Breakpoints
However, Turbo C can lose track of its breakpoints in two cases:

m If you edit a file that contains breakpoints, then abandon (fail to save) the edited
version of the file. Turbo C cannot remember where the breakpoints were

62 Turbo C User’s Guide



set in the original version of the file, and so will display them on the
wrong lines.

If you must abandon the edited version of a source file, clear all
breakpoints (choose Break/Watch/Clear All Breakpoints) and recreate
the ones you need. Note that Break/Watch/Clear All Breakpoints clears
all the breakpoints in your programs, not just those in the source file you
are editing.

n If you edit a file and then continue the current debugging session, or start a new
session without recompiling and relinking. The breakpoints are actually set
in the right places, but because the source file no longer matches the
executable program, the breakpoint highlights appear on the wrong
lines. (The execution bar also appears on the wrong lines.)

You aren’t likely to get into this situation by accident because Turbo C
displays the warning prompt Source modified, rebuild? when you try to
continue or restart the debugging session.

Before you compile a source file,you can set breakpoints on lines that
contain no executable statements, such as comments and blank lines. In that
case, Turbo C will warn you before it runs the program that the
breakpoints are set on source lines that contain no executable code. Once
you have compiled a file, Turbo C knows which lines contain executable
statements, and will warn you if you try to set breakpoints on those lines.

You can move the cursor to the next breakpoint in a file by choosing Break/
Watch/View Next Breakpoint. Note that this command moves the cursor to
the next breakpoint in the current project, not the next breakpoint that will
be executed when the program is run. You can use Break/Watch/View
Next Breakpoint to review the breakpoints in a program when you want to
clear some but not all of them.

Exercise 3: Back to the Program

Let’s see if the change you made fixed the bug.

If you have left the integrated environment or run other programs since
completing Exercise 2, load WORDCNT C into the integrated environment
again. Choose Run/Run to start a new debugging session. Run
WORDCNT up to the call to wordlen; trace into it and step through it. This
time it should work correctly and return a value of 2. Success!

Your work is not over, though. Much of this program has not yet been
tested, and it may contain more bugs.The next thing you should test is the
inner while loop in main. The most thorough approach is to step through
main until the entire first line of input has been processed and control
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leaves the loop. Verify that each step does the right thing and that control
leaves the loop at the right point.

Does that sound like a great deal of work? The debugger’s Watch window
makes it a lot easier. The Watch window displays one or more expressions
and their current values. Each time the debugger halts, it re-evaluates each
expression in the Watch window. Thus you can watch the expressions’
values change as you run your program.

You're going to create watch expressions for all the data elements that are
important in the inner while loop: the variable i, the string beginning at
wordptr, and the first few elements of wordlencnt.

The Watch window normally occupies the lower part of the screen during a
debugging session, just as the Message window does during a compile and
link. It is initially one line high and is empty. If the Watch window is
invisible, it’s because the Edit window is zoomed to full screen; press F5 to
return to a split-screen environment and reveal the Watch window.

Choose Break/Watch/Add Watch (or press the hot key combination, Ctr-
F7). The debugger opens a window and prompts you to enter a watch
expression. Like Debug/Evaluate, Break/Watch/Add Watch uses the word
at the Edit window’s cursor as a default expression. If the default
expression doesn’t happen to be i, type i; press Enter. The debugger adds the
expression i and its current value to the Watch window.

Repeat this procedure for the five expressions wordptr and wordlencnt[1]
through wordlencnt[4]. As you add each watch expression, the Watch
window grows to accommodate it. Now step through the while loop until
WORDCNT has processed the entire first line of input. As you go, you can
watch WORDCNT advance wordptr a word at a time and increment the
appropriate elements of wordlencnt. Stop when wordptr reaches the end of
the line and the execution bar leaves the inner while loop. The loop
appears to be working correctly.

Editing and Deleting Watch Expressions

You can edit and delete watch expressions in the Watch window, as well as
add them.

To edit and delete watch expressions, begin with the Watch window active.
If you're in the menu system, press F10 to leave it. Press F6 to switch from
the Edit window to the Watch window. The watch editor highlights the
expression about to be edited or deleted; you can move the highlight with
the Home, End, Up arrow, and Down arrow keys.
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First let’s edit a watch expression. Move the highlight to wordlencnt[4] and
choose Break/Watch/Edit Watch (or press Enter). The debugger opens a
window containing the watch expression, and prompts you to edit it.

Change the array index from 4 to 6 and press Enter. The debugger changes
the watch expression in the Watch window and displays the value of the
new expression.

Move the highlight to the expression wordlencnt[3] and choose Break/
Watch/Delete Watch (or press Del or Ctrl-Y). The debugger deletes the watch
expression.

Press F6 to activate the Edit window. Notice the diamond-shaped symbol
that appears before the highlighted watch expression to mark it when the
Watch window is deactivated. Press F6 again to reactivate the Watch
window.

You can delete all the watch expressions at once by choosing Break/Watch/
Remove All Watches. (You needn’t make the Watch window active to do
this). Delete all the watch expressions now. The Watch window returns to
its original empty state.

Press F6 again to reactivate the Edit window. Each time you enter this
command, it switches the active window from the Edit window to the
Watch window, or vice versa.

Zooming and Switching Windows

The rules for zooming and switching windows in the debugger are an

extension of the rules you have already learned for the editor, compiler, and
linker.

The screen is normally split between the Edit window and the Watch
window during a debugging session, just as it is normally split between the
Edit window and the Message window when you’re compiling and linking,.

To switch between the two visible windows—Edit and Message, or Edit
and Watch—press F6.

To zoom the active window to full screen, press F5. When the active
window is already zoomed, pressing F5 returns the screen to the split-
screen display. Try this now with the Edit window and the Watch window.

To display the Execution screen, select Run/User Screen, or press Alt-F5. Try
this now. Press any typing key to return to the prior display.

Use All-F6 to change the contents of a window:

s When the Edit window is active, the file loaded just before the current
file is reloaded.
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m If the Watch window or Message window is active, pressing Alt-F6 toggles
between the Watch editor and the Message tracking window.

Scrolling Watch Expressions

As you add expressions to the Watch window, it will grow to fill about half
of your screen. If you add more expressions, some will scroll out of the
window. You can get them back by scrolling the window display with the
PgUp, PgDn, Up arrow, and Down arrow keys.

If an individual watch expression is too long to fit in the window, you can
see its beginning and end by scrolling it with the Home, End, Left arrow, and
Right arrow keys (in the same way Debug/Evaluate lets you scroll long
expressions and values).

Exercise 4: Debugging the Print Loop

You've now debugged the whole of the while loop that reads and processes
the input file. There are a few places in this loop where bugs might still
lurk, but to reach them you’ll have to feed WORDCNT specific types of
input, such as empty lines. Therefore, we'll defer searching for such bugs
and go on to the for loop that prints the results.

You need to run WORDCNT up to the line that begins the for loop (it's
around Line 117). As you know, you can do that by moving the cursor to
the line, setting a breakpoint, and choosing Run/Run. This time you're
going to use another technique that’s more convenient if you expect to stop
at a certain point only once.

Move the cursor to the line that begins the for loop, and choose Run/Go to
Cursor. (You can also use the hot key, F4) The debugger runs WORDCNT
and stops on the line at the cursor. (It would stop at a breakpoint if it
encountered one first, but none are set in this part of the code.)

Run one statement, moving the execution bar to the printf in the for loop.
Notice that there is no breakpoint highlight on the for line. Run/Go to
Cursor is a one-time operation; it does not set a permanent breakpoint.

Start stepping through the for loop with Run/Trace Into. Notice that Run/
Trace Into does not trace into the printf function. That’s because printf isn’t
defined in a source file compiled with debug information. The debugger
can run such functions, but it can’t trace into them. (In this case, there’s
another reason why you can’t trace into the function: The source file for
printf isn’t on your disk.)
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Each time you run a line that contains a printf call, the debugger swaps to
the Execution screen. This permits printf to perform its output in the
proper context. The debugger displays the Execution screen every time you
run a statement containing a function, since it can’t tell which functions will
or won'’t write to the screen.

You probably won'’t be able to read the program’s output in the brief time
the Execution screen is visible, so redisplay it with Run/User Screen or All-
F5 to see what WORDCNT is doing to the screen.

Note: On the other hand, if you notice that output from your program is
overwriting your source code in the Edit window, you will want to get rid
of it by choosing Debug/Refresh Display to refresh the screen. Then check
to make sure that the Debug/Display Swapping option is set to either
Smart or Always.

(For more information on these options, see the discussion in Chapter 5.)

This completes the fourth exercise. We'll leave it to you to decide whether
there’s a bug in the for loop, and if so, how to fix it.

Note: We promise that WORDCNT contains several more bugs. Can you
find them? Each of them is mentioned somewhere in the section
“Guidelines for Effective Software Testing,” later in this chapter.

Exercise 5: Working with Large Programs

The debugger has several features to help you work with large source files
and multi-file programs. In the next few sections, we’ll demonstrate them.

To use one of the features we're going to demonstrate, you must compile
your program with the Options/Compiler/Code Generation/Standard
Stack Frame option on. Check this option now. If it’s off, turn it on, then
make sure that WORDCNT is loaded into the Edit window and recompile
by pressing All-F3.

Start a new debugging session by choosing Run/Step Over or pressing the
corresponding hot key, F8.

Finding the Definition of a Function
Debug/Find Function scrolls a function’s definition into the Edit window.
It can find any function in your program that was compiled with the

Debug/Source Debugging and O/C/C/OB] Debug Information toggles
set to On.
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Debug/Find Function is useful if you discover a bug while you are
working in one part of a program, but must fix it by changing another part.
Or it can show you a function’s code or comments to help you remember
how the function works.

To try out this command, move the cursor to that infamous line in main
that calls wordlen. Choose Run/Go to Cursor; then move the cursor to the
name wordlen and choose Debug/Find Function. The debugger opens a
window and prompts you to enter a function name; Since wordlen is the
function you want to find, type it in, then press Enter. The debugger
displays the definition of wordlen in the Edit window.

The Call Stack

When you're debugging a program that calls many levels of functions, you
sometimes need to see the call stack, which tells you what functions the
program has called, and in which order, to reach the current execution
position. This is the feature that requires the Options/Compiler/Code
Generation/Standard Stack Frame option to be on.

Trace into wordlen, then choose Debug/Call Stack, or press Ctr-F3. The
debugger displays the call stack in a pop-up window. The function now
being executed is at the top of the stack, and main is at the bottom. Notice
that the call stack displays not only the names of the functions the program
has called, but the values of their parameters.

You can display the currently executing line of any function on the call
stack by moving the call stack window’s highlight to that function and
pressing Enter. For example, to display the currently executing line of main,
move the highlight to the call stack entry for main and press Enter. The
debugger scrolls the part of main containing the call to wordlen into the
Edit window. If there were additional entries on the call stack, you could
display the currently executing line of any other function by choosing
Debug/Call Stack again and choosing another call stack entry.

Note: If you are having problems with the call stack or with qualified
variable names, make sure that the Options/Compiler/Code Generation/
Standard Stack Frame toggle is set to On, then recompile your program.

Returning to the Execution Position
You can also use the Debug/Call Stack option to return to the execution bar
after looking at another part of your program. To scroll the line with the

execution bar back into the Edit window, just choose the topmost function
on the call stack. Try it now.
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This ends the exercises relating to the debugger.

When You Can’t Use the Integrated Debugger

Some programs, for example any that take over Interrupt 9, cannot be
debugged with the Integrated Debugger. Use the stand-alone Turbo
Debugger instead.

About Multiple Source Files

All the debugger’s commands work with programs that consist of multiple
source files. For example, if you choose Debug/Find Function to find a
function that is defined in a source file other than the one in the Edit
window, the debugger loads the appropriate file into the window. If you
have made changes to the file currently in the window, the debugger asks
whether you want to save them before loading the new file.

Similarly, when you choose a function on the call stack (using Debug/Call
Stack), the debugger reloads the Edit window with the source file
containing the execution position (that is, the next line to be executed in the
current function). If you have made changes to the other file, the debugger
asks whether you want to save them before reloading the original file. If
your program consists of many source files, it is wise to debug only a few at
a time. It is easier to keep control of your work if only a few parts of the
program are changing at once.

Survey of Debugger Commands and Hot
Keys

This tutorial has presented the integrated debugger’s most often-used
commands. There are more commands that you may want to learn when
you have gained some mastery of the debugger. To find them, refer to the
two tables below.

Many debugger commands and other menu commands can be invoked by
using hot keys or key combinations. To avoid presenting a confusing
amount of detail, we’ve mentioned only the most important ones. Table 4.3
shows all the hot keys for the debugging commands you have learned.
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Table 4.3: Debugger Commands and Hot Keys

Hot Key

Menu Command

Description

F4

Ctri-F2

F8

Ctrl-F4

Cirl-F3

70

Run/Go to Cursor

Run/Program Reset

Run/Trace Into

Run/Step Over

0/C/C/Standard Stack Frame

0/C/C/O0B]J Debug Information

Debug/Evaluate

Debug/Find Function

Debug/Call Stack

Debug/Source Debugging

Runs program, stopping on line at
the cu};sogrevill initri’gte g
debugging session.

Cancels current debugging
session, releases allocated
memory, and closes files. Valid
only in debugging sessions.

Runs next statement in the current
function. If it calls a lower-level
function compiled with Debug/
Source Debtllgging and O/ CE/
OBJ Debug Intormation set to On,
traces into that function. Will
initiate a debugging session.

Runs next statement in the current
function. Does not trace into
called functions. Will initiate a
debugging session.

T?)%gles the Options/Compiler/
Code Generation/Standard Stack
Frame option. This option must be
set to On when a program is
compiled if the Debug/ Call Stack
Option is to work correctly.

Tﬁgles the O/C/C/OB] Debug
Intormation option. Only source
files compiled and linked with
this option set to On can be
debugged.

Evaluates a C expression; allows
you to modify the value of a
variable.

Finds a function’s definition and
displays it in the Edit window.
Valid only in debugging sessions.

Displays call stack. You can

display the currently executing
line of a function by choosing that
function’s name from the cal
stack. Valid only in debugging
sessions.

Controls whether debugging is
allowed. When it is set to On,
both integrated and standalone
debugging are possible. When it
is set to Standalone, you can
debt‘xig aJprograms only with the
standalone debu%éer, although

ou can still run them in TC.

en it is set to None, no
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Table 4.3: Debugger Commands and Hot Keys (continued)

debugging information is placed
in theg %ZXE file, so you canl:\ot
debug your program with either
debugger.

Adds a watch expression.
Deletes a watch expression.
Lets you edit a watch expression.

Break/Watch/Remove All Watches Deletes all watch expressions.

Ctrl-F7 Break/Watch/Add Watch
Break/Watch/Delete Watch
Break/Watch/Edit Watch

Ctri-F8

Break/Watch/ Clear Breakpoints

Break/Watch/Next Breakpoint

Break/Watch/Toggle Breakpoint

Sets or clears a breakpoint on the
line at the cursor position.

Clears all breakpoints in the pro-
gram.

Displays next breakpoint.

Table 4.4 shows other menu commands often used with the integrated
debugger. (Refer to Chapter 5 to learn the other menu command hot keys.)

Table 4.4: Menu Commands and Hot Keys Used with the Debugger

HotKey Menu Command

Description

F5

Alt-F5

F6

Alt-F6

Ctri-Fg Run/Run

Project/Remove Messages

Zooms and unzooms the active
window between full-screen and
split-screen modes.

Switches the display to the User
screen. Press any key to return to the
integrated environment.

Switches active window between the
Edit window and the Watch or
Message window.

If Edit window is active, switches to
the last file loaded into the Editor. If
lower window is active, switches
between Watch window and Message
window.

Runs a program, with or without the
debugger. Compiles source file(s) and
links program if necessary. When the
rrogram as been compiled and

inked with Debu%/eSource Debugging
and O/C/C/OB]J Debug Information
set to On, runs program to a
breakpoint or to the end of the pro-
gram.

Deletes contents of the Message
window.
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Guidelines for Effective Software Testing

There’s a lot more to testing software than knowing how to use a debugger.
Figuring out whether and why a program is misbehaving is one of the most
challenging phases of programming.

The rest of this chapter will suggest some techniques that can make your
testing work easier.

Develop a Standard Approach

Evolve a standard approach to software testing: a checklist of steps that
your experience shows will lead you to a reliable program.

There is no one “right” way to test a program; your checklist will depend
on the types of programs you write, your strengths and weaknesses as a
programmer, and your personal style. The following checklist may serve as
a starting point:

= Feed the program some input that is simple but not trivial. Trace into the
code using Debug/Evaluate, and watch expressions liberally to check the
values of data items. Correct the bugs you find, one or a few at a time.

w Feed the program other sets of data that will let you exercise the parts
you couldn’t test in the preceding step.

m Test every statement in your program. You may find bugs where you
didn’t suspect they could exist. In WORDCNT, for example, testing every
statement would reveal a vagrant semicolon after an else that has
disasterous effects when the program encounters a word more than
MAXWORDLEN characters long. (The semicolon is normally beyond the
right edge of the Edit window, and so you’d be unlikely to notice it any
other way.)

m Be alert for individual statements or expressions that must be tested
more than one way, like these:
if ( strcmp(a,b) ) . . .

strcmp can return three values, 0 (@ equals b), -1 (a is less than b), or +1 (a
is greater than b). This suggests that you should test the statement with
three sets of input values to verify that stremp makes it do the right thing
in each case.

X = (x>0) 2 func(x) : 0 ;

This statement contains an “implicit if” that can produce two different
results.

m Give special attention to boundary conditions: conditions that make a
program escape from a loop, fill an array, and so on. Bugs are especially
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likely to be manifested as failures to handle boundary conditions
correctly.

WORDCNT contains two related examples of boundary condition bugs.
First, the final for loop fails to print the element of wordlencnt that
represents words MAXWORDLEN characters long. Second, the
definition of wordlencnt allocates one element too few, so that that
element doesn’t even exist.

m Put aside the debugger and test the entire program for correct behavior.
If the program will be used by other people who will expect it to be
well-behaved, test its response to every type of error it could possibly
encounter. A program that handles most types of errors well is said to be
robust.

nIf other people will be using your program, have at least one other
person test it. Choose someone whose skills and needs are typical of your
program’s intended users, but who has enough persistence and
enthusiasm to dig out obscure bugs and report them accurately. Don’t
choose a programmer unless your program is meant to be used by
programmers.

Test Modifications Thoroughly

When you modify a program, retest the affected parts thoroughly. You may
have to retest parts that haven’t changed but are affected by the changes.

If the program is complex, keep a record of the tests you have performed.
When you modify the program, this record will help you repeat all the tests
whose results could possibly be affected by the change. If the tests involve
particular input files, save the files.

Design Defensively

You can avoid bugs by designing your program defensively, just as you can
avoid accidents by driving your car defensively.

Write your code cleanly, with consistent indention, liberal comments, and
descriptive variable names.

Keep your code simple. Express complicated operations in many simple
statements rather than a few complex ones. Turbo C’s code optimization
will make your code reasonably efficient, and it will be much easier to
debug, read, and modify.
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Try to build up your program from functions whose purposes are simple
and well-defined. This will make it easier to set up test cases and analyze
their results. It will also make your program easier to read and modify.

Try to minimize the number of data elements each function requires and
the number of elements it changes. This too will make it easier to set up test
cases and analyze their results, and to read and modify your program. It
will also tend to limit the amount of havoc a misbehaving function can
cause, allowing you to run the function several times in a single debugging
session. A program designed this way is said to be loosely coupled.

Don’t try to squeeze the last bit of efficiency out of your program when you
write it. When you try to make code as efficient as it can be, it also tends to
become hard to read and debug. If your program turns out to be too slow
when it’s done, that’s the time to decide which parts are worth speeding
up, and how best to do it.

Be alert for opportunities to write functions that can be used more than one
way in your program, or can be reused in other programs. Writing and
debugging one generalized function is usually easier than writing two or
more specialized ones.

Debug from the Bottom Up

As far as possible, concentrate on debugging your program’s lowest-level
functions (the ones that don’t call other functions) first. Then work upward
toward main. In this way, you'll get a foundation of reliable functions that
you can step over when they are called in other parts of your code.

Look for Classes of Bugs

When you find a bug, look carefully for other bugs of the same kind and/or
in the same part of the program. For example, if you find a function call
that says

fp = fopen("rb",filename);
but which should be
fp = fopen(filename,"rb");

check your code for other calls to fopen and similar functions that exhibit
the same error.
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Debugging Inline Assembly Code

If you are using the integrated development environment in conjunction
with Borland’s TASM assembler, you may step through assembly level code
without having to use an external debugger. (For full-featured assembly
level debugging, however, you should get Borland’s standalone debugger.)

When an assembly language module is assembled with TASM's -zi switch,
TC can recognize lines and symbols from the assembly source. If you step
into an assembly level function, TC will display the assembly language
source code for that function. You may use normal TC debugging
commands such as Debug/Go to cursor (F4), Debug/Trace Into (F7), and
Debug/Step Over (F8) with your assembly language source code.

Most symbols defined in your assembly language source code will be
available for you to use in evaluating expressions and watch expressions.
In addition, you have access to the pseudo-registers (_AX, _BX, etc.) and a
special _FLAGS variable that reflects the state of the CPU'’s flags register.
However, since TC is a C development environment, it will not recognize
every assembler construct or expression.

Chapter 4, Debugging Your Program 75



76

Turbo C User’'s Guide



The Turbo C Integrated
Development Environment

TC, the Turbo C integrated development environment, is much more than
just a fast C compiler; it is a fast, efficient C compiler with a built-in editor,
debugger, and other utilities that are easy to learn and easy to use. With TC,
you don’t need to use a separate editor, debugger, compiler, linker, and
Make utility in order to create and run your C programs. All these features
are built right into TC, and they are all accessible from one clear and simple
display—the main TC screen.

In This Chapter...

This chapter is divided into four sections: Part I, “Using TC;” Part II, “The
Menu Commands;” Part III, “More about Configuration and Pick Files;”
and Part IV, “Additional Features and Editing Commands.”

In Part I, “Using TC,” we

u introduce the TC command-line switches and hot keys
m describe the components of the main TC screen
m explain how to use the TC main menu choices

m demonstrate how to get into the Edit window and use the TC Editor

(editing commands are covered in Appendix A in the Turbo C Reference
Guide, “The Turbo C Interactive Editor”)

m introduce you to the TC integrated debugger (for detailed information on
how to use the debugger, see Chapter 4, “Debugging Your Program”)
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In Part II, “The Menu Commands,” we

m examine and explain each menu item’s function
m summarize the compile-time options

In Part III, “More about Configuration and Pick Files,” we

m discuss what a configuration file is and how you create and use it in TC
m discuss how to create and use a pick file in TC

In Part IV, “Additional Features and Editing Commands,” we

m discuss editing features not available through the menu system

mexplain how to customize your editing keys with the Turbo C
customization program TCINST.EXE

What You Should Read

If you are not familiar with Borland’s integrated development
environments, you will want to read Parts I and II first. If you are well-
versed in working with menu-driven products such as SideKick or Turbo
Pascal, you may want to skim these sections before reading Parts IIl and IV.

How to Get Help

Turbo C, like other Borland products, gives context-sensitive onscreen help
at the touch of a single key. You can get help at any point within any TC
menu.

To call up the Help system, press F1. The Help window explains the func-
tions of the item on which you're currently positioned. Any help screen
may contain a keyword (a highlighted item) that you can choose to get more
information. Use the arrow keys to move to any keyword and press Enter to
get more detailed help on the chosen item. You can use the Home and End
keys to go to the first and last keywords on the screen, respectively.

If you want to return to a previous help screen, you can press Alf-F1 whether
you are inside or outside the Help system. TC lets you back up through 20
previous help screens.

To get to the help index, press F1 again once you're in the Help system.

You may find that while you are in the TC Editor you need help on various
library functions. If you position the cursor under the function name (such
as printf) you want information on, then press Cir-F1, you can bring up a
help screen with the information you want.
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To exit from the Help system and return to your menu choice, press Esc or
any of the kot keys described in the next section.
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Part I: Using TC

To load the Turbo C integrated development environment (TC), type 1C
and press Enter at the DOS prompt.

The startup screen that appears includes the main TC screen and a box
containing product version information. When you press any key, the
version information disappears (pressing Shift-F10 any time will display it
again), but the main screen remains (see Figure 51).

Look closely at the main TC screen; it consists of four parts: the main menu,

the Edit window, the Message window, and the Quick Reference (Quick-
Ref) Line.

Edit Run Compile Projegﬁu Options Debug Break/watch
Line 1 Col 1 Insert Indent Tab Fil1l Unindent G:NONAME.C

Message

Fl-Help F5-Zoom F6-Switch F7-Trace F8-Step F9-Make F10-Menu

Figure 5.1: The Main TC Screen

TC Command-Line Switches

The Turbo C integrated development environment accepts the following
command-line switches:

m The /c switch causes a configuration file to be loaded. Enter the tc com-
mand, followed by /c and the configuration file name, with no space
between the two:

tc /cmyconfig.te

80 Turbo C User's Guide



(See Part I1I of this chapter for more on configuration files and pick files.)

u The /b switch causes TC to recompile and link all the files in your project,
print the compiler messages to the standard output device, and then
return to DOS. This switch allows you to invoke TC from a batch file, so
you can automate builds of projects. Before the build, TC will load either
a default configuration file or one given specially with the /c switch. TC
determines what .EXE to build based on the project file, the primary file,
or the file currently loaded into the TC Editor, in that order of
precedence. Enter the tc command with either /b alone or /c and the con-
figuration file name followed by /b.

tc /cmyconfig.tc /b
te /b

Unless the loaded configuration file specifies a project or primary file,
you can specify the name of a program to be compiled and linked on the
command line. Type in the program name after the tc command,
followed by /b:

tc myprog /b

mThe /m switch lets you do a make rather than a build (that is, only
outdated source files in your project are recompiled and linked). Follow
the instructions for the /b switch, but use /m instead.

® The /d switch causes TC to work in dual monitor mode, if it detects
appropriate hardware. Otherwise, the /d switch is ignored. Dual monitor
mode is used when you are running or debugging a program, or shelling
to DOS (File/OS Shell).

When you type in the /d switch on TC’s command line, it enables dual
monitor mode, as long as the required hardware is present (for example,
a monochrome card and a color card). If your system has two monitors,
DOS treats one monitor as the active monitor. Use the DOS MODE com-
mand to switch between the two monitors (MODE €080, for example, or
MODE MONO). In dual monitor mode, the normal TC screen will appear on
the inactive monitor, and program output will go to the active monitor.
Thus, when you type tc /d at the DOS prompt on one monitor, TC will
come up on the other monitor. When you want to test your programon a
particular monitor, you must exit TC, switch the active monitor to the
one you want to test with, then issue the tc /d command again. Program
output will then go to the monitor where you typed the tc command.

WARNING:

» Do not change the active monitor (by using the DOS MODE command,
for example) while you are in a DOS shell (File/OS Shell).

e User programs that directly access ports on the inactive monitor’s
video card are not supported, and can cause unpredictable results.
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e When you run or debug programs that explicitly make use of dual
monitors, do not use the TC dual monitor switch (/d).

Finding Your Way around TC

To help you gain familiarity with the Turbo C integrated development en-
vironment, here are some navigating basics:

From anywhere in TC:

m Press F1 to get information about your current position (help on running,
compiling, and so on).

u Press F5 to zoom/unzoom active window.

m Press F6 to switch windows.

= Press F10 to toggle between the menus and the active window.

m Press Alt-F6 to change the contents of a window (switch from Message
window to Watch window and back, or toggle between the current file
and the previous file).

m Press Alf plus the first letter of any main menu command (F,E,R,C,P, O,
D, or B) to invoke the specified command. For example, pressing Alt-E
from anywhere in the system will take you to the Edit window; Alf-F takes
you to the File menu.

From within a menu:
m Use the highlighted capital letter to choose a menu item, or use the arrow
keys to move to the option, then press Enter.
m Press Esc to exit a menu.

m In the main menu, or in one of the pull-down menus invoked from the
main menu, pressing Esc will take you directly back to the active win-
dow. (When it is active, the window will have a double bar at its top and
its name will be highlighted.)

m Press F10 to get from any menu level to the previously active window.

m Use the Right and Left arrow keys to move from one pull-down menu to
another.

To exit TC and return to DOS:

Go to the File menu and choose Quit (press Q, or move the highlight bar to
Quit and press Enten. If you choose Quit without saving your current work
file, the Editor will query whether you want to save it. (You can also use the
hot key Alt-X to quit and return to DOS.)
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The TC Hot Keys

Before we describe the various menu options available to you, there are a
number of hot keys (shortcuts) you should be aware of. Hot keys are keys
set up to perform a certain function. For example, as discussed previously,
pressing Alf and the first letter of a main menu command will take you to
the specified option’s menu or perform an action. The only other Aff/first-
letter command is Alf-X, which is really just a shortcut for File/Quit.

In addition to these Al-first-letter commands, TC has a special User screen
hot key, Alt-F5, that you use to switch from the main TC screen and a User
screen where your program output is displayed. It is equivalent to the menu
command User Screen on the Run menu.

When you are using TC, you see one of two screens—the main TC screen or
the User screen. The main TC screen is what you see when you edit,
compile, link, and debug your programs. The User screen is what you see
when you run a Turbo C executable program or temporarily exit to DOS
through the File/OS Shell menu command. When you are using the inte-
grated debugger, you will often swap the TC and User screens. TC is able to
preserve the contents of the latter screen continuously in a saved User
screen buffer, updating it each time you choose a run command (like Run,
Trace Into, or Step Over) or File/OS Shell. To view this saved screen, select
User Screen from the Run menu, or press Alt-F5.

Note: In dual monitor mode, the User screen is already displayed on one of
the two monitors in the system. Thus, the Run/User Screen command and
Alt-F5 will be disabled.

How TC determines whether it needs to clear the User screen depends on
the video mode. When TC is invoked from DOS, or when you return to it
from the DOS shell, it remembers the video mode and cursor type. These
two states are reset independently of one another whenever you shell to
DOS (File/OS Shell) or exit the integrated environment (File/Quit), if the
current state is found to be different than the remembered state. There is
one exception to this: If you shell to DOS during a debugging session
(when a program is running), the mode and cursor type are left in the state
your program put them.

Table 5.1 lists all the hot keys you can use in TC. Remember that, when
these keys are pressed, their specific function is carried out no matter
where you are in the TC environment. There is one exception: Whenever
you are presented with a dialog box that requests specific keys to be
pressed, the hot keys are disabled until you have pressed the requested key.
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Table 5.1: Turbo C Hot Keys

Key(s) Function
F1 Brings up a Help window with information about your
current position
F2 Saves the file currently in the Editor
F3 Lets you load a file (an input box will appear)
F4 Runs program to line the cursor is on
F5 Zooms and unzooms the active window
F6 Switches active windows
-F7 Runs program in debug mode, tracing into functions
F8 Runs program in debug mode, stepping over function calls
F9 Performs a “make”
F10 Toggles between the menus and the active window
Ctrl-F1 Calls up context help on functions (TC Editor only)
Ctr-F2 Resets running program '
Ctrl-F3 Brings up call stack
Ctrl-F4 Evaluates an expression
Ctrl-F7 Adds a watch expression
Ctri-F8 Toggles breakpoints On and Off
Ctr-F9 Runs program
Shift-F10 Displays the version screen
Ait-F1 Brings up the last help screen you referenced
Alt-F3 Lets you pick a file to load
Alt-F5 Switches between main TC screen and User screen
Alt-F6 Switches contents of active window
Alt-F7 Takes you to previous error
Alt-F8 Takes you to next error
Alt-F9 Compiles to .OB]J the file loaded in the TC Editor
Ait-B Takes you to the Break/Watch menu
Ait-C Takes you to the Compile menu
Alt-D Takes you to the Debug menu
Alt-E Puts you in the Editor
Alt-F Takes you to the File menu
Alt-0 Takes you to the Options menu
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Table 5.1: Turbo C Hot Keys (continued)

Alt-P Takes you to the Project menu

Alt-R Takes you to the Run menu

Alt-X Quits TC and returns you to DOS
Menu Structure

Figure 5.2 shows the complete structure of TC’s main menu and its
successive pull-down menus. There are three general types of items on the
TC menus: commands, toggles and settings.

Commands  Perform a task (running, compiling, storing options, and
so on).

Toggles Switch a TC feature On or Off (Auto Dependencies, Test
Stack Overflow, and so on) or let you cycle through and
choose one of several options by repeatedly pressing the
Enter key until you reach the item desired (such as
Message Tracking or Floating Point).

Settings Allow you to specify certain compile-time and run-time
information to the compiler, such as directory locations,
names of files, macro definitions, and so on.
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Figure 5.2: The TC Menu Structure, continued
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Menu-Naming Conventions

In this book, we often refer to menu items by an abbreviated name. The
abbreviated name for a given menu item is represented by the sequence of
letters you press to choose that item from the main menu. For example:

m At the main menu, the menu offering compile-time options related to
error messages is Options/Compiler/Errors; it may also be referred to as
O/C/Errors (press O CE, in that order).

m At the main menu, the menu for specifying the name of the include
directories is Options/Directories/Include Directories; it may be referred
to as O/D/Include Directories (press O D/, in that order).

The Main Menu

File Edit Run Compile Project Options Debug Break/watch

Figure 56.3: The TC Maln Menu Bar

At the top of the main TC screen is the TC main menu bar (see Figure 5.3),
which offers eight choices:

File Handles files (loading, saving, picking, creating, writ-
ing to disk), manipulates directories (listing, changing),
quits the program, and invokes DOS.

Edit Lets you create and edit source files.

Run Controls a running program. If you have compiled and
linked your program with the Debug/Source
Debugging and O/C/C/OB] Debug Information
toggles set to On, you can also initiate a debugging
session from this menu.

Compile Compiles and makes your programs into object and
executable files.

Project Allows you to specify what files are in your program
and manage your project.

Options Allows you to choose compiler options (such as

memory model, compile-time options, diagnostics, and
linker options) and define macros. Also records the
Include, Output, and Library file directories, saves
compiler options, and loads options from the config-
uration file.

88 Turbo C User’s Guide



Debug Allows you to check or alter the value of variables,
locate any function, and inspect the call stack while
your program is running. Also lets you choose whether
your program will compile with debugging infor-
mation in the executable code.

Break/watch  Lets you add, delete, and edit watch expressions and
set, clear, and go to breakpoints.

Note that one main menu item is a command: Edit simply takes you into
the Editor. The other menu items invoke pull-down menus with many
options and/or subsequent menus.

The Quick-Ref Lines

Whether you’re in one of the windows or one of the menus, the default
Quick-Ref Line appears at the bottom of the screen. This line provides an at-
a-glance function-key reference for your current position.

When you first enter TC, the default Quick-Ref Line looks like this:
Fl-Belp P5-Zoom F6-Switch F7-Trace F8-Step F9-Make F10-Menu

Now hold down the Alf key for a few seconds. The Quick-Ref Line will
change to describe what function will be performed when you combine
other keys with the Alt key. It looks like this:

Alt: Fl-Last help F3-Pick F6-Swap F7/F8-Prev/Next error F9-Compile

The Edit Window

In this section, we describe the components of the main TC screen and
explain how to work in the TC Edit window.

First, to get into the Edit window, press F10 to invoke the main menu, then
either move the highlight to the Edit option and press Enter or press E from
anywhere in the main menu. To get into the Edit window from anywhere
in the system, just press All-£. Once you're in the Edit window, notice that
there are double lines at the top of it and its name is highlighted—that
means it’s the active window.

Besides the Edit window, where you can see and edit several lines of your
source file, the TC screen has two information lines you should note: the
status line and the Quick-Ref Line.
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The status line at the top of the TC screen gives information about the file
you are editing, where in the file the cursor is located, and which editing
modes are activated. It looks like this:

Line Col 1Insert Indent Tab Fill Unindent * C:FILENAME, RBXT

Line n
Coln
Insert

Indent

Tab
Fill

Unindent

C:FILENAME.EXT

Cursor is on file line number n.
Cursor is on file column number n.

Insert mode is On; toggle Insert mode On and Off
with Insert or Clri-V. See Appendix A in the Turbo C
Reference Guide for an explanation of Insert and
Overwrite modes.

Autoindent is On. Toggle it Off and On with Ctr-O I
See Appendix A in the Turbo C Reference Guide for an
explanation of Autoindent mode.

Tab mode is On. Toggle it On and Off with Cti-O T.

When Tab mode is on, the Editor will fill the
beginning of each line optimally with tabs and
spaces. This option is toggled with Ctrl-O F. See
Appendix A in the Turbo C Reference Guide.

The backspace will outdent a level whenever the
cursor is on the first nonblank character of a line or
on a blank line. This option is toggled with Ctr-O U.
See Appendix A in the Turbo C Reference Guide.

The asterisk appears before the file name whenever
the file has been modified and has not yet been
saved.

The drive (C:), name (FILENAME), and extension
(.EXT) of the file you are editing.

The Quick-Ref Line at the bottom of the TC screen displays which hot key

performs what action:

Fl-Help F5-Zoom F6-Switch F7-Trace F8-Step F9-Make F10-Menu
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To choose one of these functions, press the indicated function key:

F1 Opens a Help window that provides information
about the TC editing commands.
F5 Expands the active window (in this case, the Edit

window) to full screen. Press F5 again to get back to
the split-screen environment.

F6 Switches you from one active window to another
(Edit vs. Message/Watch).

F7 (Trace) Lets you run your program one line at a time in
debugging mode, tracing into functions as they are
called.

F8 (Step) Lets you run your program one line at a time in
debugging mode, stepping over function calls.

F9 (Make) Makes (compiles and links) your .EXE file.

F10 (Menu) Takes you from the Edit window to the main menu,

and from any menu to the Edit window.

The TC Editor uses a command structure similar to that of SideKick’s
Notepad and Turbo Pascal’s editor; if you're unfamiliar with the editor
these products use, Appendix A in the Turbo C Reference Guide describes the
editing commands in detail. The most commonly used commands are listed
below.

If you're entering code in the Edit window while you‘re in Insert mode,
you can press Enter to end a line (the TC Editor has no wordwrap). The
maximum line width is 248 characters; the Edit window is 77 columns
wide. If you type past column 77, the window scrolls as you type. The TC
screen’s status line gives the cursor’s location in the file by line and column.

After you've entered your code into the Edit window, press F10 to invoke
the main menu. Your file will remain onscreen; you need only press E (for
Edit) at the main menu to return to it.

Quick Guide to Editing Commands

Here is a summary of the TC Editor commands you will use most often;
 Scroll the cursor through your text with the Up/ Down arrow,
Left/ Right arrow, and PgUp/PgDn keys
m delete a line with Ctr-Y
m delete a word with Cti-T
m mark a block with Ctr-K B (beginning) and Ctrl-K K (end)
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m move a block with Cir-K V
m copy a block with Ctr-K C
m delete a block with Ctr-K'Y

See Appendix A in the Turbo C Reference Guide for a more detailed
explanation of the Editor commands.

How to Work with Source Files in the Edit Window

When you invoke the Edit window before loading a particular file, the TC
Editor automatically names the file NONAME.C. At this point you have all
the features of the Editor at your fingertips. You can
s Create a new source file either as NONAME.C or another file name.
& Load and edit an existing file.
m Pick a file from a list of source files and load it into the Edit window.
m Save the file seen in the Edit window.
= Write the file in the Editor to a new file name.
® Alternate between the Edit window and the Message window for finding
and correcting compile-time errors.

While you are creating or editing a source file, but before you have com-
piled it, you do not need the Message window. So you can press F5 to zoom
the Edit window to full screen. Press F5 again to unzoom the Edit window
(return to split-screen mode).

Creating a New Source File

To create a new file, choose either of the following methods:

m At the main menu, choose File/New, then press Enter. This opens the Edit
window with a file named NONAME.C.

m At the main menu, choose File/Load. The Load File Name prompt box
opens; type in the name of your new source file. (Pressing the hot key F3
anywhere within TC will accomplish the same thing.)

Loading an Existing Source File

To load and edit an existing file, you can choose two options: File/Load or
File/Pick.

92 Turbo C User’s Guide



If you choose File/Load at the main menu, you can

# Type in the name of the file you want to edit; paths are accepted—for
example, CATURBOC\TESTFILE.C.

mEnter a mask in the Load File Name prompt box (using the DOS
wildcards * and ?), and press Enfer. Entering *.* will display all the files
in the current directory as well as any other directories. Directory names
are followed by a backslash (\). Choosing a directory displays the files in
that directory. Entering C:\*.C, for example, will bring up only the files
with that extension in the root directory.
Press the Up/Down and Left/ Right arrow keys to highlight the file name you
want to choose. Then press Enter to load the chosen file; you are placed in
the Edit window.

If you choose File/Pick or press All-F3 (see the discussion of the File/Pick
menu later in this chapter), you can quickly pick the name of a previously
loaded file.

There is an additional hot key to reload the previously loaded file. Press
Alt-F6 (change window contents) to switch between the file currently in the
editor and the previously loaded file.

Saving a Source File

m From anywhere in the system, press F2.
= From the main menu, choose File/Save.

Writing an Output File

You can write the file in the Editor to a new file or overwrite an existing file.
You can write to the current (default) directory or specify a different drive
and directory.

At the main menu, choose File/Write To. Then, in the New Name prompt
box, type the full path name of the new file name; for example,

C:\DIR\SUBDIR\FILENAME.EXT
and press Enter.

If the file already exists, the Editor will verify that you want to overwrite
the existing file before proceeding.

Press Esc to return to the active window (the Edit window). You can also
press All-E or F10.
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Note: For a comprehensive explanation of the TC Editor, refer to Appendix
A in the Turbo C Reference Guide.

The Message Window

You will use the Message window to view diagnostic messages when you
compile and debug your source files. TC’s unique error-tracking feature
lists each compiled file’s warnings and error messages in the Message
window and simultaneously highlights the corresponding position of the
appropriate source file in the Edit window (depending upon the setting of
the Message Tracking command on the Option/Environment menu).

When the cursor is in the Message window, the Quick-Ref Line hot keys
perform the following functions:

Fl-Belp Opens a Help window that summarizes the TC error-
tracking feature.

F5-Zoom Expands the Message window to full screen.

F6-Switch Makes the Edit window the active window.

F7-Trace Lets you run your program one line at a time in source
debug mode, tracing into functions as they are called.

F8-Step Lets you run your program one line at a time in source
debug mode, stepping over function calls.

F9-Make Makes the .EXE file.

F10-Menu Takes you from the active window to the main menu,

and from any menu to the active window.

The Watch Window

The Watch window replaces the Message window when you are running
your program with the integrated debugger. It contains watch expressions
(expressions you insert into the Watch window from your program) and
the current value of each expression. A watch expression is reevaluated
after each step or run, since its value may have changed. The Watch
window enables you to keep track of the value of important expressions
while your program is running.

As you add expressions to the Watch window, the window expands until it
reaches the size specified by the TCINST Resize Windows option. After
that you can still add expressions, but you will have to scroll the window to
see them all, using the PgUp, PgDn, Up arrow, and Down arrow keys.
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The current expression in the Watch window is marked by a highlight bar
when the window is active, and by a bullet () in the left margin when it is
not.

To edit expressions in the Watch window, you can generally use the same
edit commands that you use in the Edit window. For example, Ctrl-Y deletes
a watch expression, and Ctrl-N inserts a watch expression. The basic Watch
window editing commands are listed in the following table.

Table 5.2: Watch Window Editing Commands

Key(s) Function

Ctrl-E or Up arrow Moves cursor up

Ctrl-X or Down arrow Moves cursor down

Ctrl-S or Left arrow Scrolls watch expression right
Ctrl-D or Right armow Scrolls watch expression left
Enter Edits watch expression

Ctr-N or Ins Inserts watch expression

Ctrl-Y, Del, or Ctrl-G Deletes watch expression

When the cursor is in the Watch window, the Quick-Ref Line hot keys
perform the following functions:

F1 Opens a Help window that summarizes the TC.

F5 Expands the Watch window to full screen.

Fé6 Makes the Edit window the active window.

Ins Lets you add a watch expression to the Watch window.

Del Lets you delete a watch expression from the Watch
window.

Enter Lets you edit the current watch expression in the Watch
window.

The Integrated Debugger

The Turbo C integrated development environment includes a special built-
in debugging feature called the integrated debugger to help you find errors
(“bugs”) in your programs. For a detailed description of how to use the
integrated debugger, refer to Chapter 4. This chapter will introduce you to
the menu features you need to run a debugging session.
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The debugger operates by allowing you to stop your program at any point
as it is executing, so you can check or even alter the value of variables.

Controlling the Debugger

The parts of the program you want to debug must be compiled with the O/
C/C/OBJ] Debug Information toggle and the Debug/Source Debugging
toggle both set to On. The integrated environment then invokes the inte-
grated debugger automatically when you run the program.

When you start a debugging session with Run/Run, Turbo C compiles the
source file(s) (if necessary), links the program (if necessary), and prepares
the program to run. Then it runs the program until it reaches either a break-
point or the end of the program.

To start a debugging session when no breakpoints have been set, press F8
(Run/Step Over). The debugger will stop on the declaration of the function
main.

Once Turbo C has prepared the program to run, you are in a debugging
session, and you can use any other feature of Turbo C.

You can run your program

mone line at a time, either skipping over function calls or stepping through
the function

® from your current position to a pre-established breakpoint
® from your current position to wherever you have positioned the cursor

You can use any of these methods or all of them, in combination, and in any
order.

It is generally unwise to continue running the program after you have
modified any of the source files you are debugging. Instead, recompile your
program by choosing Compile/Make EXE File. In fact, if you have made
changes to your source file, Turbo C will ask if you want to rebuild your
.EXE file when you issue a run command like Step Over or Trace Into.
Once the rebuild has been made, TC will not ask you again until a further
change has been made in your source files.

The Debugger Screen Display
The debugger screen display consists of the Edit window on top and the

Watch window on the bottom. You can toggle between these windows by
pressing FB6.
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As watch expressions are added to the Watch window, it grows to its
maximum size (controlled by the TCINST utility’s Resize Windows option),

and then scrolls.

Your current position in the program is called the execution position. It is
indicated in the Edit window by a highlight bar called the execution bar.

Debugging Menu Commands and Hot Keys

Table 5.3 shows the special debugging menu commands.

Table 5.3: Debugger Commands and Hot Keys

Hot Key Menu Command

Description

F4 Run/Go to Cursor

Ctri-F2 Run/Program Reset

F7 Run/Trace Into

F8 Run/Step Over
0/C/C/Standard Stack Frame
0/C/C/0B] Debug Information

Ctri-F4 Debug/Evaluate

Debug/Find Function

Runs program, stopping on line at
the cursor. Will initiate a
debugging session.

Cancels current debugging
session, releases allocated
memory, and closes files. Valid
only in debugging sessions.

Runs next statement in the current
function. If it calls a lower-level
function compiled with Debug/
Source Debugging and O/ C/%Z/
OBJ Debug Intormation toggles
set to On, traces into that function.
Will injtiate a debugging session.

Runs next statement in the current
function. Does not trace into
called functions. Will initiate a
debugging session.

To%gles the Options/Compiler/
Code Generation/Standard Stack
Frame option. This option must be
set to On when a program is
compiled if the Debug/Call Stack
option is to work correctly.

T:fggles the O/C/C/OBJ] Debug
Information option. Only source
files compiled and linked with
this option set to On can be
debugged.

Evaluates a C expression; allows
you to modify the value of a
variable.

Finds a function’s definition and
displays it in the Edit window.
Valid only in debugging sessions.
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Table 5.3: Debugger Commands and Hot Keys (continued)

Ctrl-F3

Ctr-F7

Debug/Call Stack

Debug/Source Debugging

Break/Watch/Add Watch
Break/Watch /Delete Watch
Break/Watch/Edit Watch
Break/Watch/Remove All Watches
Break/Watch/Toggle Breakpoint

Break/Watch/ Clear Breakpoints

Displays call stack. You can

display the currently executing
line of a function by choosing that
function’s name from the cal
stack. Valid only in debugging
sessions.

Controls whether debugging is
allowed. When it is set to On,
both integrated and stand-alone
debugging are possible. When it
is set to Standalone, you can
debug programs only with the
standalone debugger, although
W}?can still run them in TC.
. ben it is set f:)o None, no laced
e ing information is plac
in tltleg% file, so you canrr’lot
debug your program with either
debugger.

Adds a watch expression.
Deletes a watch expression.

Lets you edit a watch expression.
Deletes all watch expressions.

Sets or clears a breakpoint on the
line at the cursor position.

Clears all breakpoints in the pro-
gram,

Break/Watch/View Next Breakpoint Displays next breakpoint.
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Table 5.4 shows other menu commands that are often used when you are

running the debugger.

Table 5.4: Menu Commands and Hot Keys Used with the Debugger

HotKey Menu Command

Description

F5

Alt-F5

Fé

Alt-F6

Ctri-F9 Run/Run

Project/Remove Messages

" and 0/C/C/OBJ

Zooms and unzooms the active
window between full-screen and
split-screen modes.

Switches the display to the User
screen. Press any key to return to the
integrated environment.

Switches active window between the
Edit window and the Watch or
Message window.

If Edit window is active, switches to
the last file loaded into the Editor. If
lower window is active, switches
between Watch window and Message
window.

Runs a program, with or without the
debugger. om&ailes source file(s) and
links program if nec . When the

rogram has been compiled and

inked with Debu%/eSource Debugging

bug Information

set to On, runs program to a
breakpoint or to the end of the pro-
gram.

Deletes contents of the Message
window.
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Part II: The Menu Commands

The main menu contains the major choices you'll use to load, edit, compile,
link, debug, and run Turbo C programs. The eight menu choices include
File, Edit, Run, Compile, Project, Options, Debug, and Break/Watch, each
of which will be described here. A few of the options within the main menu
pull-downs are actually for use in advanced programming; they are
described in more detail in Chapter 3.

Note: The references to “make” in this chapter refer to Project-Make, not to
the stand-alone MAKE utility. Project-Make is a program building tool
similar to MAKE; refer to Chapter 3 for more on Project-Make. The MAKE
utility is described in Appendix D in the Turbo C Reference Guide.

The File Menu

The File pull-down menu offers various choices for loading existing files,
creating new files, and saving files. When you load a file, it is placed in the
Editor. When you finish with a file, you can save it to any directory or file
name. In addition, from the File menu you can change to another directory,
temporarily go to a DOS shell, or exit Turbo C.

Edit Run Compile ma.ieg'tﬂ . Options Debug Break/watch
Col 1 Insert Indent Tab Fi11 Unindent G:NONAME.C

Directory
Change dir
0S shell
Quit  Alt-X

Message

Fl-Help F5-Zcom F6-Switch F7-Trace F8-Step F9-Make F10-Menu

Figure 5.4: The Flle Menu
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Load

Loads a file. You can use DOS-style masks (for example, *.C) to get a listing
of file choices, or you can load a specific file. Simply type in the name of the
file you want to load.

Note: If you enter an incorrect drive or directory, you'll get an error box
onscreen. You'll get a verify box if you have an unsaved, modified file in
the Editor while you're trying to load another file. In either case, the hot
keys are disabled until you press the key specified in the error or verify
box.

Pick

Lets you pick a file from a pick list of the previous eight files loaded into the
Edit window. The file chosen is then loaded into the Editor, and the cursor
is positioned at the location where you last edited that file. If you choose
the “--load file--" item from the pick list, you'll get a Load File Name
prompt box exactly as if you had chosen File/Load or pressed F3. Al-F3is a
shortcut for the File/Pick command. The integrated environment can save
this list of file names from one editing session to another, if you create a pick
file to hold it.

See the section on the Options/Directories/Pick File Name command
(page 129) for details on how to create a pick file.

New

Specifies that the file is to be a new one. You are placed in the Editor; by

default, this file is called NONAME.C. (You can change this name later
when you save the file.)

Save
Saves the file in the Editor to disk. If your file is named NONAME.C and

you go to save it, the Editor will ask if you want to rename it. From
anywhere in the system, pressing the F2 hot key will save your file.

Write To

Prompts for a file name and writes the contents of the Editor to that file. If a
file by that name already exists, this command causes it to be overwritten.
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Directory

Displays the directory and file set you want (to get the current directory,
just press Enfer). F4 allows you to change the wildcard mask. Choose a file
name to load that file into the Editor.

Change Dir

Displays the current directory and allows you to change to a specified drive
and directory.

OS Shell

Leaves Turbo C temporarily and takes you to the DOS prompt. To return to
Turbo C, type EXIT. This is useful when you want to run a DOS command
without quitting Turbo C.

Note: In dual monitor mode, the DOS shell will come up on the TC screen
rather than the User screen. This allows you to shell to DOS without
disturbing the output of your program. Since your program output is
available on one monitor in the system, Run/User Screen and Alt-F5 will be
disabled.

Quit
Quits Turbo C and returns you to the DOS prompt.
The hot key for this command is Af-X.

The Edit Command

The Edit command invokes the built-in screen Editor.

You can invoke the main menu from the Editor by pressing F10 (or Alt and
the first letter of the main menu command you desire). Your source text
remains displayed on the screen; you need only press Esc or E at the main
menu to return to it (or press Alf-E from anywhere).
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The Run Menu

The Run menu’s commands run your program, and also start and end
debugging sessions. In order to use any of the Run commands except Run/
Run, you must have compiled and linked your program with the Debug/
Source Debugging toggle set to On.

Flle Edit [ Compile Project Options Debug Break/watch

Line 1 _m b Fi11 Unindent G:NONAME.C
Program reset Ctrl-F2

6o to cursor F4
Trace into F?
Step over F8

User screen Alt-F5

Message

Alt: Fl-Last help F3-Pick F6-Swap F7/F8-Prev/Next error F9-Compile

Figure 5.5: The Run Menu

Run

Run/Run runs your program, using the arguments you pass to it with
Options/Arguments. If the source code has been modified since the last
compilation, it will also invoke Project-Make to recompile and link your
program. (Project-Make is a program building tool incorporated into the
integrated environment; see Chapter 3 for more on this feature.)

If you don’t want to debug your program, compile and link it with the
Debug/Source Debugging toggle set to None or to Standalone. If you
compile your program with this toggle set to On, the resulting executable
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code will contain debugging information that will affect the behavior of the
Run/Run command in the following ways:

If you have not modified your source code since the last compilation:

m The Run/Run command will cause your program to run to the next
breakpoint, or to the end if no breakpoints have been set.

If you have modified your source code since the last compilation:
u If you are already stepping through your program using Run/Step Over

(F8) or Run/Trace Into (F7), Run/Run will cause a prompt to appear
onscreen asking whether you want to rebuild your program.

o If you press Y, Project-Make will recompile and link your program, and
set it to run from the beginning. '

o If you press N, your program will run to the next breakpoint, or to the
end if no breakpoints are set.

mIf you are not yet stepping through your program, Project-Make will
recompile your program and set it to run from the beginning.

The hot key for the Run/Run command is Ctrl-F9.

Program Reset

Run/Program Reset cancels the current debugging session. It releases
memory your program has allocated, and closes any open files. The hot key
for Run/Program Reset is Clrl-F2.

Go to Cursor

Run/Go to Cursor runs your program from the execution bar to the line
the Edit window cursor is on. If the cursor is at a line that does not contain
an executable statement, the command warns you by bringing up an Esc
box. Run/Go to cursor can also initiate a debug session.

Go to Cursor does not set a permanent breakpoint, but does allow the pro-
gram to stop at a permanent breakpoint if it encounters one before the line
the cursor is on. If this occurs, you must reissue the Go to Cursor com-
mand.

Use Go to Cursor to advance the execution bar to the part of your program
you want to debug. If you want your program to stop at a certain statement
every time it reaches that point, set a breakpoint on that line.

The hot key for Run/Go to Cursor is F4.
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Trace Into

Run/Trace Into runs the next statement in the current function. If the
statement contains no calls to functions accessible to the debugger, Trace
Into halts at the next executable statement.

If the statement does contain a call to a function accessible to the debugger,
Trace Into halts at the beginning of the function’s definition. Subsequent
Trace Into or Step Over commands will run the statements in the function’s
definition. When the debugger leaves the function, it will resume eval-
uating the statement that contains the call.

A function is accessible to the debugger if it is defined in a source file that
was compiled with both the O/C/C/OB] Debug Information and the
Debug/Source Debugging toggles set to On, and the debugger can find the
source file on your disk.

Use Trace Into to move the execution position into a function called by the
function you are now debugging.

The hot key for the Run/Trace Into command is F7.

Step Over

Run/Step Over executes the next statement in the current function. It does
not trace into calls to lower-level functions, even if they are accessible to the
debugger.

Use Step Over to run the function you are now debugging, one statement
at a time.

Here is an example of the difference between Run/Trace Into and Run/
Step Over. These are the first twelve lines of a program loaded into the
Editor:

int findit(void) /* Line 1 */
{

return(2);

}

void main(void) /* Line 6 */
{

int i, 3;

i = findit(); /* Line 10 */
printf("%d\n*, i); /* Line 11 %/
j=0; ... /* Line 12 #/
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findit is a user-defined function in a module that has been compiled with
debugging information. Let’s say that the execution bar is on Line 10 of
your program.

u If you now select Run/Trace Into, the execution bar will move to the first
line of the findit function (Line 1 of your program), allowing you to step
through the function.

mIf you select Run/Step Over, the findit function will execute and the
return value will be assigned to i. Then the execution bar will move to
Line 11.

If the execution bar had been on Line 11 of your program, it would have
made no difference which command you selected; Run/Trace Into and
Run/Step Over would both have executed the printf function and moved
the execution bar to Line 12. This is because the printf function does not
contain debug information.

The hot key for the Run/Step Over command is F8.

User Screen

The User Screen is where Turbo C displays the output from your program.

When your program finishes executing, you are returned to the main TC
screen. To look at your output, choose User Screen from the Run menu, or
press the corresponding hot key, Alt-F5.

When you are through examining your output, press any key to return to
the Integrated Development Environment.

The Compile Menu

You use the items on the Compile menu to compile to an .OB] file (Compile
to OB]), to make an .EXE file (Make EXE File), to link an .EXE file (Link EXE
File), to Build All, to set a Primary C File, and to get information about the
last compilation or run (Get Info).
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File Edit Run Project Options Debug Break/watch
Line 1 Col G:NONAME.C

Compile to 0BJ
3

ake e
Link EXE file
Build all
Primary C file:
Get info

,,,,,

Message

Fl-Help F5-Zoom F6-Switch F7-Trace F8-Step F9-Make F10-Menu

Flgure 5.6: The Compile Menu

Compile to OB]J

This command compiles a .C file to an .OB] file. It always displays the name
of the file to be produced; for example, C:EXAMPLE,0BJ. The .OBJ file name
listed is derived from one of two names, in the following order:

u the primary .C file name, or, if none is specified,

m the name of the last file you loaded into the Edit window

When Turbo C is compiling, a window pops up to display the compilation
results. When compiling/making is complete, press any key to remove this
compiling window. If any errors occurred, you are automatically placed in

the Message window at the first error (which is highlighted). This Compile
command and its options are explained in more detail in Chapter 3.

The hot key for this command is Alt-F9.

Make EXE File

This command invokes Project-Make to make an .EXE file. It always
displays the name of the .EXE file to be produced; for example,

C:EXAMPLE.EXE.

Chapter 5, The Turbo C Integrated Development Environment 107



The .EXE file name listed is derived from one of three names in the
following order:

m the project file (.PR]) specified with Project/Project Name, or, if none is
specified,

m the primary C file name specified with Primary C File, or, if none is
specified,

m the name of the last file you loaded into the Edit window.

The hot key for this command is F9.

Link EXE File

Takes the current .OBJ and .LIB files (either the defaults or those defined in
the current project file) and links them without doing a make; this produces
a new .EXE file.

Build All

Rebuilds all the files in your project regardless of whether they are out of
date. This option is similar to Compile/Make EXE File, except that it is
unconditional; Compile/Make EXE File rebuilds only the files that aren’t
current. This command first sets the date and time of all the project’s .OB]
files to zero, then does a make. (Thus, if you break a Build All command
with Ctrl-Break, you can cause it to pick up where it left off simply by
choosing C/Make EXE File.)

Primary C File

The Primary C File command is useful (but not required) when you’re
compiling a single .C file that includes multiple header (.H) files. If an error
is found during compilation, the file containing the error (which might be a
.C file or a .H file) is automatically loaded into the Editor so you can correct
it. (Note that the .H file is only automatically loaded if you have changed
the default setting of Options/Environment/Message Tracking to All Files;
using the default settings will not cause automatic loading of the .H file.)
The primary .C file is then recompiled when you press Alf-F9, even if it is
not in the Editor.

Get Info

Compile/Get Info calls up a window that gives you information on
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® primary file

m object file name associated with the current file
@ name of current source file '
m size in bytes of current source file

m program exit code

m available memory

File Edit Run Project Options Debug Break/watch

Current directory : G:\PUBLIC\NETFILES\C\C2\
Current file ¢ G:\PUBLIC\NETFILES\C\C2\HELLO.C
File size : 104 (Max: 64605)

EMS usage : 6K

: 0 No program running.
: 0 Program exit code
: 0 Available memory: 112K

Lines compiled
Total warnings
Total errors

Press any key

Col | Compile to 0BJ G:HELLO.0BJ * G:HELLO.C

Message

Fl-Help F5-Zoom F6-Switch F7-Trace F8-Step F9-Make F10-Menu

HAgure 5.7: The Compile/Get Info screen

The Project Menu

The commands on the Project menu allow you to combine multiple source

and object files to create finished programs.
For more information on Project, refer to Chapter 3.
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File Edit Run Compile Options Debug Break/watch

Linel1  Coll Insert c
Break make on rrors
Auto dependencies Off
Clear project

Remove messages

Message

Fl-Help F5-Zoom F6-Switch F7-Trace F8-Step F9-Make F10-Menu

Figure 6.8: The Project Menu

Project Name
Chooses a project file containing the names of the files to be compiled and/

or linked. The project name is given to the .EXE and .MAP files when they
are created. A typical project file has the extension .PR].

Break Make On

This menu lets you specify the default condition for stopping a make: if the
file has Warnings, Errors, or Fatal Errors, or before linking (Link).
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File Edit Run Compile Cptions Debug Break/watch
Line 1 Col 1 Insert| Project name c

to dependencies
Clear project Warnings
Remove messages lﬂw
Fatal errors

Link

Message

Fl-Help F5-Zoom F6-Switch F7-Trace F8-Step F9-Make F10-Menu

Figure 5.9: The Project/Break Make On Menu

Auto Dependencies

This option is a toggle. If you set it to On, Project-Make will automatically
check dependencies for every .OBJ file on disk that has a corresponding .C
source file in the project list.

Project-Make opens the .OBJ file and looks for information about files
included in the source code. This information is always placed in the .OB]J
file by both TC and TCC when the source module is compiled. Then every
file that was used to build the .OB] file is checked for time and date against
the time/date information in the .OB] file. The .C source file is recompiled
if the dates are different.

This is called an autodependency check.

If the Auto Dependencies option is toggled to Off, no such file checking
will be done.

Clear Project

This command clears the project name and resets the Message window.
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Remove Messages

This command clears the error messages from the Message window.

The Options Menu

The Options menu contains settings that determine how the integrated en-
vironment works. These settings affect things like compiler and linker
options, library and include directories, program run-time arguments, and
so on. The items on this menu call up more menus, one setting, and two
commands that perform managerial tasks, as follows:

m Compiler (calls up more menus)

m Linker (calls up more menus)

m Environment (calls up more menus)

m Directories (calls up more menus)

m Arguments (setting)

m Save Options (performs task)

® Retrieve Options (performs task)

File Edit Run Compile m.legﬁu Debug  Break/watch

Line 1 Col 1 Insert Indent Ta W_ NONAME.C
nker

Envircnment
Directories
Arguments

Save cptions
Retrieve options

Message

F1-Help FS-Zoom F6-Switch F7-Trace F8-Step F9-Make F10-Menu

Figure 5.10: The Opticns Menu
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Compiler

The options on this menu allow you to specify particular hardware config-
urations, memory models, debug techniques, code optimizations, diag-
nostic message control, and macro definitions. The items in this menu,
described in the next several pages, are as follows:

m Model

m Defines

m Code Generation
m Optimization

m Source

m Errors

m Names

File Edit Run Compile ProjecE:“ Debug Break/watch
Line1  Col 1 Insert Indent Ta|NETYAISAENN |NONAME.C

Model Small
Defines

Code generation
Optimization

Source

Errors

Names

Message

Fi-Help F5-Zoom FG6-Switch F7-Trace F8-Step F9-Make F10-Menu

Fgure 5.11: The Options/Compller Menu

The Model menu

These commands are the different memory model switches available in
Turbo C. The memory model chosen determines the default method of
memory addressing. The options are Tiny, Small, Compact, Medium,
Large, and Huge. The default memory model is Small, so normally the
word “Small” appears to the right of the menu choice Model. Refer to
Chapter 12 for more information about these memory models.
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File Edit Run Compile Project Debug  Break/watch

t
Line 1 Col 1 Insert Indent Ta lNONAHE.C
Model Smail ‘
DeTines |
Code generation Tin
Optimization E@.
Source Medium
Errors Compact
Names Large
Huge
Message

Fl-Help FS5-Zoom F6-Switch F7-Trace F8-Step F9-Make F10-Menu

Figure 5.12: The O/C/Model Menu

Defines

Choosing Defines opens up a macro definition box in which you can pass
macro definitions to the preprocessor. Multiple “defines” can be separated
by semicolons (;). Values can be assigned optionally with an equal sign (=).

Leading and trailing spaces are stripped, but embedded spaces are left
intact. If you want to include a semicolon in a macro, you must place a
backslash (\) in front of it.

Here’s a macro that defines the symbol BETA_TEST, sets ONE to 1, and
COMPILER equal to the string TURBOC:

BETA TEST; ONE = 1; COMPILER = TURBOC

The Code Generation Menu

These options tell the compiler to prepare the object code in various ways.
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File Edit Run Compile Project Debug  Break/watch

t
Linel  Col 1 Insert Indent Ta[SeCETALTANNNN]NONANE.C
Model Small

Defines

Calling convention

08¢

Floating point Emati

Default char type Signed
Alignment Byte
Generate underbars On

Merge duplicate strings Off
Standard stack frame On
Test stack overflow off
Line numbers off
0BJ debug information on

Message

Fl-Help F5-Zoom F6-Switch F7-Trace FB8-Step F9-Make F10-Menu

Figure 5.13: The O/C/Code Generation Menu

Calling Convention:

Causes the compiler to generate either a C calling sequence or a Pascal
(fast) calling sequence for function calls. The differences between C and
Pascal calling conventions are in the way each handles stack cleanup,
number and order of parameters, case and prefix (underbar) of external
identifiers.

Do not change this option unless you're an expert and have read Chapter 12 on
advanced programming techniques.

Instruction Set:

Permits you to specify a different target CPU; this is a toggle between an
8088/8086 instruction set and an 80x86 instruction set. The default gener-
ates 80x86 code. Turbo C can generate extended 80x86 instructions. You
will also use this option to generate 80x86 programs running in the real
mode, such as with the IBM PC AT under MS-DOS 3.x.
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Floating Point:
This toggle allows for three options:

m 8087/80287, which generates direct 8087/80287 inline code.

m Emulation, which detects whether you have an 8087/80287 and uses it if
you do—otherwise, it emulates the 8087/80287 just as accurately, but at a
slower pace.

m None, which assumes you're not using floating point. (If None is chosen
and you use floating-point calculations in your program, you will get
link errors.)

Default Char Type:

Toggles between Signed and Unsigned char declarations. If you choose
Signed, the compiler will treat all char declarations as if they were signed
char type; and vice versa for choosing Unsigned. The default value is
Signed.

Alignment:

This allows you to toggle between word-aligning and byte-aligning. With
word-aligning, noncharacter data aligns at even addresses. With byte-
aligning, data can be aligned at either odd or even addresses, depending on
which is the next available address. Word-alignment increases the speed
with which 8086 and 80286 processors fetch and store the data.

Generate Underbars:
By default, this option is toggled to On.

Don’t change this unless you're an expert and have read Chapter 12 on advanced
programming techniques.

Merge Duplicate Strings:

This optimization merges strings when one string matches another, produ-
cing smaller programs. The default is Off.

Standard Stack Frame:

Generates a standard stack frame (standard function entry and exit code).
This is helpful when you use a debugger—it simplifies the process of
tracing back through the stack of called subroutines. The default is On.

The Standard Stack Frame option is a toggle. If a source file is compiled
with this option set to Off, any function that does not use local variables
and has no parameters is compiled with abbreviated entry and return code.
This makes the code shorter and faster, but prevents Debug/Call Stack
from “seeing” the function. Thus, the toggle should always be set to On
when a source file is compiled for debugging.

116 Turbo C User’s Guide



Test Stack Overflow:

Generates code to check for a stack overflow at run time. Although this
costs space and time in a program, it can be a real lifesaver; a stack
overflow can be a difficult bug to track down. The default is Off.

Line Numbers:

Includes line numbers in the object map file (for use by a symbolic
debugger). This increases the size of the object and map files but will not
affect speed of the executable program. (The size of the executable program
will increase if the Debug/Source Debugging toggle is set to On, and you
are linking in object files that were created with the O/C/C/Line numbers
switch toggled on; the additional size is due to the debugging information.)
The default is Off.

Since the compiler may group together common code from muitiple lines
of source text during jump optimization, or may reorder lines (which
makes line-number tracking difficult), we recommend setting Options/
Compiler/Optimization/Jump Optimization to Off when this option is On.

OB] Debug Information:

Controls whether debugging information is included in object (.OB]J) files.
This toggle defaults to On, which allows both integrated debugging and
debugging with the standalone Turbo Debugger.
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The Optimization Menu

The options in this menu allow you to optimize your code to your own pro-
gramming needs.

File Edit Run Compile ijegt“ Debug  Break/watch

d

Line1l  Col 1 Insert Indent Ta|NETTXAITSNENSNNN]NONAME.C
Mcdel Small
Defines

Code generation
Optimize for Size
Use register variables O

n
Register optimization Off
Jump optimization off

Message

Fl-Help F5-Zoom F6-Switch F7-Trace F8-Step F9-Make F10-Menu

Figure 5.14: The O/C/Optimization Option

Optimize For:

Changes Turbo C’s code generation strategy. Normally the compiler uses
Optimize for...Size, choosing the smallest code sequence possible. With this
item toggled to Optimize for...Speed, the compiler will choose the fastest
sequence for a given task.

Use Register Variables:

Suppresses or enables the use of register variables. With this option set to
On, register variables are automatically assigned for you. With this option
set to Off, the compiler does not use register variables even if you have
used the register keyword (see Appendix C in the Turbo C Reference Guide
for more details).

Generally, you can keep this option set to On unless you are interfacing
with preexisting assembly code that does not support register variables.
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Register Optimization:

Suppresses redundant load operations by remembering the contents of
registers and reusing them as often as possible.

Note: You should exercise caution when using this option because the
compiler cannot detect whether a value has been modified indirectly by a
pointer. Refer to Appendix C in the Turbo C Reference Guide for a detailed
explanation of this limitation.

Jump Optimization:

Reduces the code size by eliminating redundant jumps and reorganizing
loops and switch statements. The loop reorganizations can speed up tight
inner loops.

Note: When this switch is set to On, the sequences of tracing and stepping
in the integrated debugger can be confusing, since there may be multiple
lines of source code associated with a particular generated code sequence.
For best results, turn this switch Off while you are debugging.

The Source Menu

The items on this menu govern how the compiler treats your source code
during the initial phases of the compilation.

File Edit Run Compile Projeg: Debug  Break/watch
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ANSI keywords only Off
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Figure 5.15: The O/C/Source Menu
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Identifier Length:

Specifies the number of significant characters in an identifier. All identifiers
are treated as distinct only if their first N characters are distinct. This
includes variables, preprocessor macro names, and structure member
names. The number given can be any value from 1 to 32; the default is 32.

Nested Comments:

Allows you to nest comments in Turbo C source files. Nested comments are
not normally allowed in C implementations, and they are not portable.

ANSI Keywords Only:

Toggle to On when you want the compiler to recognize only ANSI
keywords and treat any Turbo C extension keywords as normal identifiers.
These keywords include near, far, huge, asm, cdecl, pascal, interrupt, _es,
-ds, _cs, _ss, and the register pseudo-variables (_AX, _BX, ...). This option
also defines the symbol __STDC__ during compiles.

The Errors Menu

With the commands on this menu, you govern how the Turbo C compiler
deals with and responds to diagnostic messages.

File Edit BRun Compile Project Debug  Break/watch
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Agure 5.16: The O/C/Errors Menu
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Errors: Stop After:

This option causes compilation to stop after a specified number of errors
have been detected. The default is 25; however, you can enter any number
from 0 to 255. (Entering 0 will cause compilation to continue indefinitely.)

Warnings: Stop After:

Choosing this option causes the compilation to stop after 100 warnings
have been detected. However, 100 is only the default; the legal range is 0 to
255, where entering 0 will cause compilation to continue indefinitely or
until the error limit has been reached.

Display Warnings:

By default, this is set to On, which means that any or all of the following
warning types can be displayed if chosen:

m Portability Warnings

m ANSI Violations

s Common Errors

» Less Common Errors

When this item is set to Off, none of the warnings will be displayed. These

warning messages are discussed in more detail in Appendixes B and C in
the Turbo C Reference Guide.
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Figure 5.17: Displaying the Common Errors
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The Names Menu

With the items in this menu, you can change the default segment, group,
and class names for code, data, and BSS sections.
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Agure 5.18: The O/C/Names Option

When you choose one of these items, the asterisk (*) on the next menu that
appears tells the compiler to use the default names.

Don'’t change this option unless you are an expert and have read Chapter 12 on
advanced programming techniques.

Linker

The items on this menu deal with setting options for the linker. Refer to
Appendix D in the Turbo C Reference Guide for more information about
these settings.
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